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1 HP Photosmart D5300 series Help
For information about the HP Photosmart, see:

• “HP Photosmart overview” on page 5
• “Find more information” on page 9
• “Computer connection information” on page 11
• “How do I?” on page 13
• “Load paper” on page 15
• “Print from your computer” on page 27
• “Use the photo features” on page 47
• “Maintain the HP Photosmart” on page 53
• “Shop for ink supplies” on page 67
• “HP warranty and support” on page 131
• “Technical information” on page 137
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2 HP Photosmart overview
Use the HP Photosmart to print photos from a memory card or print labels on printable
CD/DVD discs. The Two-sided printing accessory included with the HP Photosmart lets
you print on both sides of the page, so you can print brochures and booklets, or just save
paper. You can access many HP Photosmart functions directly from the control panel,
without turning on your computer.

This section contains the following topics:

• The HP Photosmart at a glance
• Control panel features
• Display icons
• Use the HP Photosmart Software

The HP Photosmart at a glance

Label Description

1 Color graphics display (also referred to as the
display)

2 Control panel

3 Memory card slots and Photo light

4 Output tray

5 Paper tray extender (also referred to as the tray
extender)

6 CD/DVD carrier storage

7 CD/DVD holder

8 Main input tray (also referred to as the input tray)

9 Photo tray

10 CD/DVD tray
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Label Description

11 Print cartridge door

12 Two-sided printing accessory

13 Rear USB port

14 Power connection*

* Use only with the power adapter supplied by HP.

Control panel features
The following diagram and related table provide a quick reference to the HP Photosmart
control panel features.

Label Icon Name and Description

1  Color graphics display (also referred to as the display): Shows photos on a memory
card. Also shows status and error messages.

2 Attention light: Indicates a problem occurred. See the display for more information.

3 Left arrow: The left button returns to the previous display screen or photo on the
memory card.

4 OK: Selects a photo for printing or selects a menu option.

5 Right arrow: The right button will navigate to the next display screen or photo on the
memory card.

6 Print Photos: Prints the photos selected on your memory card. If no photos are
currently selected, the HP Photosmart prints the photo currently showing on the
display.

7 Photo Tray: Selects the Photo Tray for the next photo you print from a memory card.

8 Red-Eye Removal: Turns the Red-Eye Removal feature On or Off. By default, this
feature is turned off. When the feature is turned on, the HP Photosmart automatically
corrects red eye coloring in the photo currently shown on the display.
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Label Icon Name and Description

9 Cancel: Stops the current operation and returns to the main screen.

10 On: Turns the HP Photosmart on or off. When the HP Photosmart is off, a minimal
amount of power is still supplied to the device. You can further reduce power
consumption by holding down the On button for 3 seconds. This will put the
HP Photosmart in Standby/Off state. To completely remove power, turn the
HP Photosmart off, and then unplug the power cord.

Display icons
The following icons can appear at the bottom of the display to provide important
information about the HP Photosmart.

Icon Purpose

Shows the print cartridge status. The color of the icon corresponds to the color
of the print cartridge, and the fill level of the icon corresponds to the fill level of
the print cartridge.

NOTE: The ink level icons will only appear if one of the print cartridges is less
than 50% full. If the ink level for all print cartridges is more than 50% full, the print
cartridge icons do not appear on the display.

Shows that the print cartridge is nearly empty, and will need to be replaced.

Shows that an unknown print cartridge is inserted. This icon might appear if a
print cartridge contains non-HP ink.

Use the HP Photosmart Software
The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and
viewing your photos.

For more information on using the HP Photosmart Software:

• Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.

• If you do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

(continued)
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3 Find more information
You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP Photosmart.

Setup Guide
The Setup Guide provides instructions for setting up the HP Photosmart and
installing software. Make sure you follow the steps in the Setup Guide in order.
If you have problems during setup, check the Setup Guide for troubleshooting
information, or see “Troubleshooting” on page 69 in this onscreen Help.

HP Photosmart  
2600 series printer 
User Guide

Basics Guide
The Basics Guide contains an overview of the HP Photosmart, including step-
by-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart animations
The HP Photosmart animations, located in the relevant sections of the onscreen
Help, show you how to complete key tasks on the HP Photosmart. You will learn
how to load paper, insert a memory card, and replace ink.

Onscreen Help
The onscreen Help provides detailed instructions on using all features of the
HP Photosmart.

• The How Do I? topic provides links so you can quickly find information on
performing common tasks.

• The HP Photosmart overview topic provides general information about
the main features of the HP Photosmart.

• The Troubleshooting topic provides information about resolving errors
you might encounter with the HP Photosmart.

Readme
The Readme file contains the most recent information which might not be found
in other publications.
Install the software to access the Readme file.

www.hp.com/support If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.

Find more information 9
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4 Computer connection
information
The HP Photosmart comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also share the device over an existing home
network.

This section contains the following topics:

• Supported connection types
• Use printer sharing

Supported connection types

Description Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection One computer connected
with a USB cable to the
rear USB 2.0 High Speed
port on the
HP Photosmart.

All features are
supported.

Follow the Setup Guide
for detailed instructions.

Printer sharing Up to five computers.
The host computer must
be turned on at all times,
or the other computers
will not be able to print to
the HP Photosmart.

All features resident on
the host computer are
supported. Only print is
supported from the other
computers.

Follow the instructions in
“Use printer sharing”
on page 11.

Use printer sharing
If your computer is on a network, and another computer on the network has an
HP Photosmart connected to it by a USB cable, you can print to that printer using printer
sharing.

The computer directly connected to the HP Photosmart acts as the host for the printer
and has full software functionality. The other computer, which is referred to as a client,
has access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP Photosmart.

To enable printer sharing on a Windows computer
▲ Refer to the user guide that came with your computer or see the Windows onscreen

Help.

Computer connection information 11
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5 How do I?
This section contains links to commonly performed tasks, such as sharing and printing
photos and optimizing your print jobs.

• “How do I print up to 13 x 18 cm (5 x 7 inch) borderless photos from a memory
card?” on page 48

• “How do I get the best print quality?” on page 30
• “How do I print on both sides of the paper?” on page 37
• “How do I print custom labels on printable CD/DVDs?” on page 36
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6 Load paper
You can load many different types and sizes of paper in the HP Photosmart, including
letter or A4 paper, photo paper, transparencies, and envelopes. In addition, the
HP Photosmart lets you load and print directly on the surface of specially coated CDs
and DVDs. By default, the HP Photosmart is set to detect the size and type of paper you
load in the input tray automatically and then adjust its settings to generate the highest
quality output for that paper.

If you are using special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality using the Automatic setting, you can
manually set the paper size and type.

This section contains the following topics:

• Choose papers for printing
• Load paper
• Load a CD/DVD
• Avoid paper jams

Choose papers for printing
You can use different types and sizes of paper in the HP Photosmart. Review the following
recommendations to get the best printing quality. Whenever you change paper types or
sizes, remember to change those settings.

This section contains the following topics:

• Recommended papers for printing
• Papers to avoid

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. Using paper that is too thin or too thick,
paper that has a slick texture, or paper that stretches easily can cause paper jams. Using
paper that has a heavy texture or does not accept ink can cause printed images to smear,
bleed, or not fill in completely.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus Photo Paper
HP Premium Plus Photo Papers are the best HP photo paper, with image quality and
fade resistance superior to store-processed photos. They are ideal for printing your high-
resolution images for framing or including in a photo album. These papers are available
in several sizes, including 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x
7 inch), A4, and 8.5 x 11 inch.

HP Premium Photo Paper
HP Premium Photo Papers are high-quality, glossy-finish or soft gloss-finish photo
papers. They look and feel like store-processed photos and can be mounted under glass
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or in an album. These papers are available in several sizes, including 10 x 15 cm (4 x 6
inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), A4, and 8.5 x 11 inch.

HP Advanced Photo Paper or HP Photo Paper
HP Advanced Photo Paper or HP Photo Paper is a sturdy, glossy photo paper that
features an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm
(4 x 6 inch) (with or without tabs), and 13 x 18 cm (5 x 7 inch). HP Advanced Photo
Paper is marked on the nonprinting corners with the following symbol:

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency Film
make your color presentations vivid and even more impressive. This film is easy to use
and handle and dries quickly without smudging.

HP Premium Inkjet Paper
HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.

HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.

HP Inkjet-Printable CD/DVD Discs
HP Inkjet-Printable CD and DVD optical discs are offered in both white and silver matte
finishes. Personalize CDs and DVDs with titles, graphics or photos by printing directly on
the discs with a optical disc-capable printer.

HP All-in-One Paper or HP Printing Paper
• HP All-in-One Paper is specifically designed for HP Photosmart devices. It has an

extra bright blue-white shade that produces sharper text and richer colors than
ordinary multifunction papers.

• HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or
copy paper.

HP Iron-On Transfers
HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.
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HP Premium Photo Cards
HP Premium Photo Cards enable you to make your own greeting cards.

HP Brochure & Flyer Paper
HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.

HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.

HP CD/DVD Tattoos
HP CD/DVD Tattoos allow you to personalize your CDs and DVDs by printing high-
quality, low-cost CD or DVD labels.
To order genuine HP supplies for the HP Photosmart, go to www.hp.com/buy/supplies.
If prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Papers to avoid
Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smear, bleed, or not fill in completely.

Papers to avoid for all print jobs
• Any size paper other than those listed in “Technical information” on page 137 or in

the printer driver.
• Paper with cutouts or perforations (unless specifically designed for use with HP inkjet

devices).
• Highly textured stock, such as linen. It might not print evenly, and the ink can bleed

into these papers.
• Extremely smooth, shiny, or coated papers not specifically designed for the

HP Photosmart. They can jam the HP Photosmart or repel the ink.
• Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,

and the ink is more likely to smear.
• Envelopes with clasps or windows. They can get stuck in the rollers and cause paper

jams.
• Banner paper.

Load paper
This section describes the procedure for loading different types and sizes of paper into
the HP Photosmart for your printouts.

Load paper 17
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TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
a resealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the
HP Photosmart.

This section contains the following topics:

• Load full-size paper
• Load up to 13 x 18 cm (5 x 7 inch) photo paper
• Load postcards, Hagaki, or index cards
• Load envelopes
• Load other types of paper

Load full-size paper
You can load many types of letter or A4 paper into the main input tray of the
HP Photosmart.

To load full-size paper
1. Raise the output tray to load paper into the main input tray.
2. Slide the paper-width guide to its outermost position.

3. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:
• Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
• Make sure all the paper in the stack is the same size and type.
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4. Insert the stack of paper into the main input tray with the short edge forward and the
print side down. Slide the stack of paper forward until it stops.

CAUTION: Make sure that the HP Photosmart is idle and silent when you load
paper into the main input tray. If the HP Photosmart is servicing the print cartridges
or otherwise engaged in a task, the paper stop inside the device might not be in
place. You could push the paper too far forward, causing the HP Photosmart to
eject blank pages.

TIP: If you are using letterhead, insert the top of the page first with the print side
down.

5. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the main input tray; make sure the stack of paper fits within the main
input tray and is no higher than the top of the paper-width guide.

6. Lower the output tray. Pull the output tray extender towards you, as far as it will go.

NOTE: When you use legal-size paper, leave the tray extender closed.

Related topics
• “Recommended papers for printing” on page 15
• “Change the print settings for the current job” on page 28

Load up to 13 x 18 cm (5 x 7 inch) photo paper
You can load up to 13 x 18 cm (5 x 7 inch) photo paper into the photo tray of the
HP Photosmart. For the best results, use 13 x 18 cm (5 x 7 inch) HP Premium Plus Photo
Paper or HP Premium Photo Paper.

Load paper 19
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To load up to 13 x 18 cm (5 x 7 inch) photo paper in the photo tray
1. Raise the photo tray lid to load photo paper in the photo tray.
2. Insert the stack of photo paper into the photo tray with the short edge forward and the

print side down. Slide the stack of photo paper forward until it stops.
If the photo paper you are using has perforated tabs, load the photo paper so that the
tabs are closest to you.

3. Slide the paper-length and paper-width guides inward against the stack of photo
paper until the guides stop.
Do not overload the photo tray; make sure the stack of photo paper fits within the
photo tray and is no higher than the top of the paper-width guide.

4. Lower the photo tray lid.

Related topics
• “Recommended papers for printing” on page 15
• “Print photos from the control panel” on page 48
• “Print a borderless image” on page 35
• “Print a photo on photo paper” on page 35

Load postcards, Hagaki, or index cards
You can load postcards, Hagaki, and index cards in the photo tray.

To load postcards, Hagaki or index cards in the photo tray
1. Raise the photo tray lid to load cards in the photo tray.
2. Insert the stack of cards into the photo tray with the short edge forward and the print

side down. Slide the stack forward until it stops.
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3. Slide the paper-length and paper-width guides inward against the stack of cards until
the guides stop.
Do not overload the photo tray; make sure the stack of cards fits within the photo tray
and is no higher than the top of the paper-width guide.

4. Lower the photo tray lid.

Related topics
“Change the print settings for the current job” on page 28

Load envelopes
You can load one or more envelopes into the main input tray of the HP Photosmart. Do
not use shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.

To load envelopes
1. Raise the output tray to load envelopes in the main input tray.
2. Remove all paper from the main input tray.
3. Insert one or more envelopes into the far-right side of the main input tray, with the

envelope flaps on the left and facing up. Slide the stack of envelopes forward until it
stops.

4. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the main input tray; make sure the stack of envelopes fits within the
main input tray and is not higher than the top of the paper-width guide.
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5. Lower the output tray.
6. Pull the output tray extender towards you, as far as it will go.

Related topics
“Change the print settings for the current job” on page 28

Load other types of paper
The following types of paper are designed for special projects. Create your project in the
HP Photosmart Software or another application, set the paper type and size, and then
print.

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
▲ Insert the film so that the white transparency strip (with arrows and the HP logo) is on

top and is going into the input tray first.

NOTE: For best results, set the paper type to transparency film before printing
on transparency film.

HP Iron-On Transfers
1. Flatten the transfer sheet completely before using it; do not load curled sheets.

TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.

2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.

HP Greeting Cards, HP Photo Greeting Cards, or HP Textured Greeting Cards
▲ Insert a small stack of HP greeting card paper into the input tray with the print side

down; slide the stack of cards forward until it stops.

TIP: Make sure the area on which you want to print is inserted first, print side
down in the input tray.

Inkjet labels
1. Always use letter or A4 label sheets designed for use with inkjet devices, and make

sure that the labels are no more than two years old. Labels on older sheets might
peel off when the paper is pulled through the HP Photosmart, causing subsequent
paper jams.

2. Fan the stack of labels to make sure none of the pages are sticking together.
3. Place a stack of label sheets on top of full-size plain paper in the input tray, label side

down. Do not insert labels one sheet at a time.

For best results, set the paper type and paper size before printing.
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HP CD/DVD Tattoo labels
▲ Place one sheet of CD/DVD tattoo paper in the input tray with the print side down;

slide the CD/DVD tattoo paper forward until it stops.

NOTE: When you use CD/DVD tattoo labels, leave the tray extender closed.

Related topics
• “Change the print settings for the current job” on page 28
• “Recommended papers for printing” on page 15

Load a CD/DVD
In addition to printing on paper, the HP Photosmart enables you to print directly on the
surface of specially coated CDs and DVDs for print jobs started from a connected
computer. You can design and create a custom label for your CD or DVD using the
software that came with the HP Photosmart. You can then print the label on your printable
CD or DVD media.

TIP: It is recommended that you write your data to the CD or DVD before printing
the label on it.

NOTE: The HP Photosmart does not support a CD/DVD print job started from the
control panel.

To load a CD/DVD on the CD/DVD tray
1. Carefully remove the CD/DVD holder that came with the HP Photosmart.

The CD/DVD holder is stored below the main input tray.

Load a CD/DVD 23
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2. Securely snap the inkjet printable media onto the CD/DVD holder with the printable
side up. The CD/DVD should be placed on the ring at the end of the holder with the
arrows.

NOTE: If you are using a smaller-sized media, flip the CD/DVD holder ring over
the CD/DVD.

3. Lower the CD/DVD tray.
The CD/DVD tray is located just below the control panel. When in its lowered position,
the CD/DVD tray sits on top of the output tray.
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4. Push the CD/DVD holder into the HP Photosmart until the lines on the CD/DVD holder
line up to the white lines on the CD/DVD tray.

NOTE: The HP Photosmart pulls the CD/DVD holder while printing on the media.
The CD/DVD holder might protrude about 7.5 cm (3 inches) at the back of the
device. If the HP Photosmart is placed close to a wall, move it at least 3 inches
away from the wall.

NOTE: Refer to the software that came with the HP Photosmart for printing on CD/
DVDs.

Avoid paper jams
To help avoid paper jams, follow these guidelines.

• Remove printed papers from the output tray frequently.
• Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
• Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
• If you are printing labels, ensure that the label sheets are no more than two years old.

Labels on older sheets might peel off when the paper is pulled through the
HP Photosmart, and cause paper jams.

• Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure
the paper-width guide does not bend the paper in the input tray.

• Do not force paper too far forward in the input tray.
• Use paper types that are recommended for the HP Photosmart.

Related topics
• “Recommended papers for printing” on page 15
• “Papers to avoid” on page 17
• “Clear paper jams” on page 71
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7 Print from your computer
The HP Photosmart can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.
You can also automatically print on both sides of the page using the Two-sided printing
accessory included with the HP Photosmart to print brochures and booklets, or just save
paper.

This section contains the following topics:

• Print from a software application
• Make the HP Photosmart the default printer
• Change the print settings for the current job
• Change the default print settings
• Printing shortcuts
• Perform special print jobs
• Stop a print job

Print from a software application
Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.

To print from a software application
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Select the HP Photosmart as the printer.

If you set the HP Photosmart as the default printer, you can skip this step. The
HP Photosmart will already be selected.

4. If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.
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5. Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

Make the HP Photosmart the default printer
You can set the HP Photosmart as the default printer to use from all software applications.
This means that the HP Photosmart is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is
automatically selected when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job
You can customize the print settings of the HP Photosmart to handle nearly any print
task.

This section contains the following topics:

• Set the paper size
• Set the paper type for printing
• View the print resolution
• Change the print speed or quality
• Change the page orientation
• Scale the document size
• Change the saturation, brightness, or color tone
• Preview your print job

Set the paper size
The Size setting helps the HP Photosmart determine the printable area on the page.
Some of the paper size choices have a borderless equivalent, which allows you to print
to the top, bottom, and side edges of the paper.

Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set
the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.
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To set the paper size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Resizing Options area, from the Size drop-down list, select More.
7. Select the appropriate paper size, and then click OK.

The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in
the Size list to see if a defined paper size already exists for the type of paper you are
using.

Paper type Suggested paper size settings

CD/DVD tattoo paper 5 x 7 in.

Copier, multi-purpose, or
plain papers

Letter or A4

Envelopes Appropriate listed envelope size

Greeting-card papers Letter or A4

Index cards Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers Letter or A4

Iron-on T-shirt transfers Letter or A4

Labels Letter or A4

Legal Legal

Letterhead Letter or A4

Panorama photo paper Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers 4 x 6 inch (with or without tab), up to 5 x 7 inch (with or without
tab), letter, A4, or an appropriate listed size

Transparency films Letter or A4

Custom-size papers Custom paper size

Set the paper type for printing
If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.
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To set the paper type for printing
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, from the Paper Type drop-down list, select More.
7. Select the type of paper that you have loaded, and then click OK.

View the print resolution
The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.

To view the print resolution
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your

project.
7. In the Paper Type drop-down list, select the type of paper that you have loaded.
8. Click the Resolution button to view the print resolution dpi.

Change the print speed or quality
The HP Photosmart automatically chooses a print quality and speed setting depending
on the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.

To select a print speed or quality
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
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6. In the Print Quality drop-down list, select the appropriate quality setting for your
project.

NOTE: To view the maximum dpi that the HP Photosmart will print, click
Resolution.

7. In the Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation
The page orientation setting allows you to print your document vertically or horizontally
on the page.

Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.

To change the page orientation
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, click one of the following:

• Click Portrait to print the document vertically on the page.
• Click Landscape to print the document horizontally on the page.

Scale the document size
The HP Photosmart allows you to print the document at a different size than the original.

To scale the document size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Resizing options area, click Scale to paper size, and then click the

appropriate paper size from the drop-down list.

Change the saturation, brightness, or color tone
You can change the intensity of colors and the level of darkness in your printout by
adjusting the Saturation, Brightness, or Color Tone options.
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To change the saturation, brightness, or color tone
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Color tab.
6. Click the Advanced Color Settings button.
7. Move the sliders to adjust the Saturation, Brightness, or Color Tone.

• Brightness indicates the lightness or darkness of the printed document.
• Saturation is the relative purity of printed colors.
• Color Tone affects the perceived warmth or coolness of printed colors, by adding

more orange or blue tones, respectively, to your image.

Preview your print job
You can preview your print job before sending it to the HP Photosmart. This helps to
prevent wasting paper and ink on projects that do not print as expected.

To preview your print job
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Select the print settings appropriate for your project on each of the tabs in the dialog
box.

6. Click the Features tab.
7. Select the Show Preview Before Printing check box.
8. Click OK, and then click Print or OK in the Print dialog box.

Your print job displays in the preview window.
9. In the HP preview window, do one of the following:

• To print, click Start Printing.
• To cancel, click Cancel Printing.

Change the default print settings
If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.
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To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Settings.
2. Make changes to the print settings, and click OK.

Printing shortcuts
Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.

NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is, change them, or create your own
shortcuts for commonly used tasks.

Use the Printing Shortcuts tab for the following print tasks:

• General Everyday Printing: Print documents quickly.
• Photo Printing–Borderless: Print to the top, bottom, and side edges of 10 x 15 cm

(4 x 6 inch) and 13 x 18 cm (5 x 7 inch) HP Photo Papers.
• Photo Printing–With White Borders: Print a photo with a white border around the

edges.
• Fast/Economical printing: Produce draft-quality printouts quickly.
• Presentation printing: Print high-quality documents, including letters and

transparencies.
• Two-sided (Duplex) Printing: Print two-sided pages with the HP Photosmart.
This section contains the following topics:

• Create printing shortcuts
• Delete printing shortcuts

Related topics
• “Print a borderless image” on page 35
• “Print a photo on photo paper” on page 35
• “Print on transparencies” on page 41
• “Print on both sides of the page” on page 37

Create printing shortcuts
In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.

If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply
select it when printing on transparency film rather than changing the print settings each
time.
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To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut.

The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.
7. Click Save as and type a name for the new printing shortcut, and then click Save.

The printing shortcut is added to the list.

Delete printing shortcuts
You might want to delete printing shortcuts that you no longer use.

To delete a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.

The printing shortcut is removed from the list.

NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Perform special print jobs
In addition to supporting standard print jobs, the HP Photosmart can perform special jobs
such as printing borderless images, iron-on transfers, and posters.

This section contains the following topics:

• Print a borderless image
• Print a photo on photo paper
• Print custom CD/DVD labels
• Print using Maximum dpi
• Print on both sides of the page
• Print a multiple-page document as a booklet
• Print multiple pages on a single sheet
• Print a multiple-page document in reverse order
• Reverse an image for iron-on transfers
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• Print on transparencies
• Print a group of addresses on labels or envelopes
• Print a poster
• Print a Web page

Print a borderless image
Borderless printing lets you print to the top, bottom, and side edges of up to 13 x 18 cm
(5 x 7 inch) photo paper.

TIP: For the best results, use HP Premium Photo Papers or HP Premium Plus Photo
Papers to print your photos.

To print a borderless image
1. Load up to 13 x 18 cm (5 x 7 inch) paper in the photo tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Size list, click More, and then select the size of photo paper loaded in the photo

tray.
If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.

7. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

8. Select the Borderless check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the HP Photosmart
software displays an alert and allows you to select a different type or size.

9. Click OK, and then click Print or OK in the Print dialog box.

Print a photo on photo paper
To achieve the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing along with genuine HP ink. HP papers
and HP ink are specifically designed to work well together to provide high-quality output.

For photo printing, HP recommends that you use HP Premium Plus Photo Papers with
the HP Photosmart.

To print a photo on photo paper
1. Load up to 13 x 18 cm (5 x 7 inch) paper in the photo tray or full-size photo paper in

the main input tray.
2. On the File menu in your software application, click Print.
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3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, from the Paper Type drop-down list, select More. Then,

select the appropriate photo paper type.
7. In the Resizing Options area, from the Size drop-down list, select More. Then, select

the appropriate paper size.
If the paper size and paper type are not compatible, the HP Photosmart software
displays an alert and allows you to select a different type or size.

8. In the Basic Options area, select a high print quality, such as Best or Maximum
dpi from the Print Quality drop-down list.

9. In the HP Real Life Technologies (RTL) area, click the Photo fix drop-down list and
select from the following options:
• Off: applies no HP Real Life technologies to the image.
• Basic: automatically focuses the image; moderately adjusts image sharpness.
• Full: automatically lightens dark images; automatically adjusts sharpness,

contrast, and focus of images; automatically removes red-eye.
10. Click OK to return to the Properties dialog box.
11. If you want to print the photo in black and white, click the Color tab and select the

Print in grayscale check box.
12. Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.

Print custom CD/DVD labels 
You can use the HP Photosmart Software or online templates from the HP Web site to
create and print a custom label for a CD or DVD. You can print directly onto the surface
of an inkjet printable CD/DVD or onto CD/DVD tattoo paper, which you affix to a CD/DVD.

To print directly onto a CD/DVD
1. Use the software that came with the HP Photosmart to create and print a CD/DVD

label.
2. When prompted, load a CD/DVD into the CD/DVD tray on the HP Photosmart.

To print a CD/DVD tattoo
1. Use the HP Photosmart Software, or go to www.hp.com to access templates for

creating CD/DVD labels.
2. Load 13 x 18 cm (5 x 7 inch) CD/DVD tattoo paper in the photo tray.
3. On the File menu in your software application, click Print.
4. Make sure the HP Photosmart is the selected printer.
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5. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

6. Click the Features tab.
7. In the Paper Type drop-down list, click More, and then select HP CD/DVD tattoo

paper from the list.
8. Click OK, and then click Print or OK in the Print dialog box.

Related topics
“Load a CD/DVD” on page 23

Print using Maximum dpi
Use Maximum dpi mode to print high-quality, sharp images.

To get the most benefit from Maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the Maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP Photosmart will print.

Printing in Maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.

NOTE: If a photo print cartridge is also installed, the print quality is enhanced. A
photo print cartridge can be purchased separately if it is not included with the
HP Photosmart.

To print in Maximum dpi mode
1. Load up to 13 x 18 cm (5 x 7 inch) paper in the photo tray or full-size photo paper in

the main input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper Type drop-down list, click More, and then select the appropriate paper

type.
7. In the Print Quality drop-down list, click Maximum dpi.

NOTE: To view the maximum dpi that the HP Photosmart will print, click
Resolution.

8. Select any other print settings that you want, and then click OK.

Print on both sides of the page
You can print on both sides of the page using the Two-sided printing accessory included
with the HP Photosmart to print brochures and booklets, or just save paper.

When printing two-sided pages, make sure to use paper that is thick enough so that
images do not show through to the other side. HP recommends using high-quality paper
such as HP Bright White Inkjet Paper or HP Brochure & Flyer Paper.
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To print on both sides of the page
1. Load paper into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper saving options area, from the Two-sided printing drop-down list,

select either On or Automatic depending on your software.
7. Click OK, and then click Print or OK in the Print dialog box.

Print a multiple-page document as a booklet
The HP Photosmart allows you to print your document as a small booklet, which you can
fold and then staple together.

For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.

To print a multiple-page document as a booklet
1. Load paper into the input tray.

The paper should be thick enough so that the images do not show through to the
other side.

2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Paper saving options area, from the Two-sided printing drop-down list,

select either On or Automatic depending on your software.
7. Select the binding edge from the Booklet layout list, as appropriate for your

language.
• If your language reads left-to-right, click Left edge binding.
• If your language reads right-to-left, click Right edge binding.
The Pages per sheet box is automatically set to two pages per sheet.

8. Click OK, and then click Print or OK in the Print dialog box.
The HP Photosmart begins printing.
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9. Wait until the HP Photosmart has stopped printing for several seconds before
removing any of the printed pages from the output tray.
If you remove the pages while the document is still printing, the pages might get out
of order.

10. When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.

TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.

1 3 5

7911

Figure 7-1 Left-edge binding for left-to-right languages

135

7 9 11

Figure 7-2 Right-edge binding for right-to-left languages

Print multiple pages on a single sheet
You can print up to 16 pages on a single sheet of paper.

To print multiple pages on a single sheet
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
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4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Pages per sheet list, click 2, 4, 6, 8, 9, or 16.
7. If you want a border to appear around each page image printed on the sheet of paper,

select the Print page borders check box.
8. In the Page order list, click an appropriate page order option.

The sample output graphic is numbered to show how the pages will be ordered if you
select each option.

9. Click OK, and then click Print or OK in the Print dialog box.

Print a multiple-page document in reverse order
Because of the way the paper feeds through the HP Photosmart, the first page that prints
is print side up at the bottom of the stack. Usually this means you need to put the printed
pages in the correct order.

1
2
3
4
5

A better way is to print the document in reverse order so that the pages are stacked
correctly.

5
4
3
2
1

TIP: Set this option as a default setting so you do not have to remember to set it
every time you print a multiple-page document.

To print a multiple-page document in reverse order
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
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4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Advanced tab.
6. In the Layout Options area, select Front to Back in the Page Order option.

NOTE: If you set your document to print on both sides of the page, the Front to
Back option is not available. Your document will automatically print in the correct
order.

7. Click OK, and then click Print or OK in the Print dialog box.

NOTE: When you are printing multiple copies, each set is printed completely
before the next set is printed.

Reverse an image for iron-on transfers
This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.

To reverse an image for iron-on transfers
1. On the File menu in your software application, click Print.
2. Make sure the HP Photosmart is the selected printer.
3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Features tab.
5. In the Paper Type drop-down list, click More, and then select HP Iron-on Transfer

from the list.
6. If the selected size is not what you want, click an appropriate size in the Size list.
7. Click the Advanced tab.
8. In the Printer Features area, select On from the Mirror Image drop-down list.
9. Click OK, and then click Print or OK in the Print dialog box.

NOTE: To prevent jams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies
For the best results, HP recommends you use HP transparency products with the
HP Photosmart.

To print on transparencies
1. Load the transparency into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.

Perform special print jobs 41

Pr
in

t



4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Basic Options area, from the Paper Type drop-down list, select More. Then

select the appropriate paper type.

TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.

7. In the Resizing Options area, from the Size drop-down list, select More. Then, select
an appropriate size.

8. Click OK, and then click Print or OK in the Print dialog box.

NOTE: The HP Photosmart automatically waits for transparencies to dry before
releasing them. Ink dries slower on film than on plain paper. Make sure you allow
enough time for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes
With the HP Photosmart, you can print on a single envelope, a group of envelopes, or
label sheets designed for inkjet printers.

To print a group of addresses on labels or envelopes
1. Print a test page on plain paper first.
2. Place the test page on top of the label sheet or envelope, and hold both up to the

light. Check the spacing for each block of text. Make adjustments as needed.
3. Load the labels or envelopes into the main input tray.

CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.

4. Slide the paper-length and paper-width guides inward against the stack of labels or
envelopes until the guides stop.

5. If you are printing on envelopes, do the following:
a. Display the print settings, and click the Features tab.
b. In the Resizing Options area, click the appropriate envelope size in the Size list.

6. Click OK, and then click Print or OK in the Print dialog box.
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Print a poster
You can create a poster by printing a document on multiple pages. The HP Photosmart
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

To print a poster
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP Photosmart is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Advanced tab.
6. Expand Document Options, and then expand Printer Features.
7. In the Poster Printing drop-down list, click either 2x2 (4 sheets), 3x3 (9 sheets),

4x4 (16 sheets), or 5x5 (25 sheets).
This selection tells the HP Photosmart to enlarge your document so that it fits on 4,
9, 16, or 25 pages.
If your originals are of multiple pages, each of those pages will be printed on 4, 9, 16,
or 25 pages. For example, if you have a one-page original and you select 3x3, you
will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.

8. Click OK, and then click Print or OK in the Print dialog box.
9. After the poster has printed, trim the edges of the sheets and tape the sheets together.

Print a Web page
You can print a Web page from your Web browser on the HP Photosmart.

If you use Internet Explorer 6.0 or higher for Web browsing, you can use HP Smart Web
Printing to ensure simple, predictable web printing with control over what you want and
how you want it printed. You can access HP Smart Web Printing from the toolbar in
Internet Explorer. For more information about HP Smart Web Printing, see the help file
provided with it.
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To print a Web page
1. Make sure you have paper loaded in the main input tray.
2. On the File menu in your Web browser, click Print.

The Print dialog box appears.
3. Make sure the HP Photosmart is the selected printer.
4. If your Web browser supports it, select the items on the Web page that you want to

include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.

5. Click Print or OK to print the Web page.

TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job
Although you can stop a print job from either the HP Photosmart or the computer, HP
recommends you stop it from the HP Photosmart for best results.

NOTE: Although most software applications designed for Windows use the
Windows print spooler, your software application might not use the spooler. An
example of a software application that does not use the Windows print spooler is
PowerPoint in Microsoft Office 97.

If you cannot cancel your print job by using one of the following procedures, consult
the instructions for canceling background printing in the online help for your software
application.

To stop a print job from the HP Photosmart
▲ Press Cancel on the control panel. If the print job does not stop, press Cancel again.

It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to cancel.
4. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows XP users)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.
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3. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.
5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows Vista users)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.
3. Double-click the HP Photosmart icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.
5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key

on your keyboard.
It can take a few moments for the print job to be cancelled.
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8 Use the photo features
The HP Photosmart is equipped with memory card slots that enable you to insert a
memory card and begin printing photos without uploading your photos to a computer first.
Additionally, if the HP Photosmart is connected to a computer with a USB cable, you can
also save your photos to the computer to later print, edit, or share them.

The HP Photosmart supports the memory cards described below. Each type of memory
card can only be inserted in the appropriate slot for that card, and only one card may be
inserted at a time.

CAUTION: Do not insert more than one memory card at a time. If more than one
memory card is inserted, unrecoverable data loss might occur.

1 xD-Picture Card

2 Secure Digital (SD), Secure Digital Mini (adapter required), Secure Digital High Capacity
(SDHC), MultiMediaCard (MMC), MMC Plus, MMC Mobile (RS-MMC; adapter required),
TransFlash MicroSD Card, or Secure MultiMedia Card

3 CompactFlash (CF) types I and II

4 Memory Stick, Memory Stick Pro, Memory Stick Select, Memory Stick Magic Gate, Memory
Stick Duo or Duo Pro (adapter optional), or Memory Stick Micro (adapter required)

The memory card area also has a Photo light. This light blinks green when a memory
card is being read or when an image is being printed from a card, and stays solid green
when images are ready to be viewed. The Photo light is located near the memory card
slots and is indicated by a camera icon.

CAUTION: Do not pull out the memory card while the Photo light is flashing. A
flashing light means the HP Photosmart is accessing the memory card. Wait until the
light remains solid. Removing a memory card while it is being accessed might corrupt
information on the card or damage the HP Photosmart or memory card.
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This section contains the following topics:

• Print photos from the control panel
• Save photos to your computer
• Edit photos
• Share photos using HP Photosmart Software

Print photos from the control panel
The HP Photosmart enables you to print photos directly from your memory card without
first transferring the files to a computer. You can print borderless photos (one per sheet
of paper) or you can print multiple photos on a single sheet of paper.

By default, the HP Photosmart is set to detect the type of paper you are using
automatically. For the best results when printing photos, leave the Paper Type set to
Automatic, and load photo paper in the photo tray. You should only change the Paper
Type if you see print quality issues using the Automatic setting.

To achieve the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing along with genuine HP ink. HP papers
and HP ink are specifically designed to work well together to provide high-quality output.

NOTE: All photos that you print from the control panel, rather than from your
computer, will be borderless.

This section contains the following topics:

• Print up to 13 x 18 cm (5 x 7 inch) photos
• Print enlargements

Print up to 13 x 18 cm (5 x 7 inch) photos
You can select specific photos on your memory card to print up to 13 x 18 cm (5 x 7 inch)
photos.

To print up to 13 x 18 cm (5 x 7 inch) photos
1. Insert your memory card into the appropriate slot on the HP Photosmart.

The most recent image on the card appears on the display.

2. Load up to 13 x 18 cm (5 x 7 inch) photo paper in the photo tray.
3. If the Photo Tray light is off, select the photo tray by pressing the Photo Tray button

(the light will turn on).
4. Press  or  to scroll through your photos until the photo you want to print appears.
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5. Press the OK button to select the photo you want to print.
Each time you press the OK button, you increment the number of copies of the
selected photo to be printed.

6. Press the Print Photos button.

TIP: While the photo is printing, you can continue scrolling through the photos
on your memory card. When you see a photo you want to print, you can press the
Print Photos button to add that photo to the print queue.

7. If you increased the number of copies or selected additional photos to print, do one
of the following in the Select Format screen:
• Press the OK button to accept the default of 1-Up.

The photos will be printed on separate pages.
• Press the  button to highlight 3-Up, and then press the OK button.

The photos will be printed on the same page (up to 3 per page).

Print enlargements
You can print the photos on your memory card in a variety of sizes, up to the size of letter
(8.5 x 11 inch) or A4 (210 x 297 mm) paper.

To print an enlargement of your photo
1. Insert your memory card into the appropriate slot on the HP Photosmart.

The most recent image on the card appears on the display.

2. Load the photo tray with up to 13 x 18 cm (5 x 7 inch) photo paper, or load the main
input tray with full-size paper.

3. Press the  or  buttons to scroll through your photos until the photo you want to
print appears.

4. Press the OK button to select the photo you want to print.
Each time you press the OK button, you increment the number of copies of the
selected photo to be printed.
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5. Press the Print Photos button.

TIP: While the photo is printing, you can continue scrolling through the photos
on your memory card. When you see a photo you want to print, you can press the
Print Photos button to add that photo to the print queue.

6. If you increased the number of copies or selected additional photos to print, do one
of the following in the Select Format screen:
• Press the OK button to accept the default of 1-Up.

The photos will be printed on separate pages.
• Press the  button to highlight 3-Up, and then press the OK button.

The photos will be printed on the same page (up to 3 per page).

Save photos to your computer
You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card to your computer’s hard drive for advanced photo editing, sharing
photos online, printing from your computer, and creating special projects such as printing
a photo directly onto an HP Photosmart CD or DVD.

Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the
HP Photosmart.

NOTE: The HP Photosmart must be connected to a computer that has the
HP Photosmart Software installed on it.

To save photos
1. Insert a memory card into the appropriate slot on the HP Photosmart.

The software opens on your computer.
2. Click Save, and then follow the onscreen prompts on your computer to save the

photos to your computer.
Only images that were not previously saved are copied to your computer.

Edit photos
The HP Photosmart automatically enhances your photos (brightening and sharpening
them), before you print them. You can also manually remove "red eye" from your photos.
Additional editing features are available using the software that you installed with the
HP Photosmart.

This section contains the following topics:

• Remove red-eye
• Edit photos using your computer
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Remove red-eye
The flash on a camera (especially on older model cameras) can sometimes cause a
subject's eyes to appear red in your photos. You can remove redness so that eyes appear
the correct shade in your photos.

NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card.

To remove red-eye from photos
1. Insert your memory card into the appropriate slot on the HP Photosmart.

The most recent image on the card appears on the display.

2. Press the  or  buttons to scroll through your photos until the photo you want to
print appears.

3. Press the OK button to select the photo you want to edit.
4. Press Red-Eye Removal on the control panel.

Edit photos using your computer
You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card to your computer’s hard drive for advanced photo editing, sharing
photos online, printing from your computer, and creating special projects such as printing
a photo directly onto an HP Photosmart CD or DVD.

Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the
HP Photosmart.

NOTE: The HP Photosmart must be connected to a computer that has the
HP Photosmart Software installed on it.

To edit photos
1. Insert a memory card into the appropriate slot on the HP Photosmart.

The software opens on your computer.
2. Click View, and then follow the onscreen prompts to transfer your photos to the

computer for viewing and editing.

Share photos using HP Photosmart Software
You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card to your computer’s hard drive for advanced photo editing, sharing
photos online, printing from your computer, and creating special projects such as printing
a photo directly onto an HP Photosmart CD or DVD.
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Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the
HP Photosmart.

NOTE: The HP Photosmart must be connected to a computer that has the
HP Photosmart Software installed on it.

To share photos
1. Insert a memory card into the appropriate slot on the HP Photosmart.

The software opens on your computer.
2. Click Share, and then follow the onscreen prompts to transfer your photos to the

computer for sharing with friends and relatives.
HP Photosmart Share lets you share photos with friends and family by sending photos
as e-mail, uploading photos to an online photo album, or ordering prints through an
online photo-finishing service.
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9 Maintain the HP Photosmart
The HP Photosmart requires little maintenance. You might need to replace, align, or clean
your print cartridges from time to time ensure that your printouts are always of the highest
quality. This section provides instructions for keeping the HP Photosmart in top working
condition. Perform these simple maintenance procedures as necessary.

This section contains the following topics:

• Work with print cartridges
• Clean the HP Photosmart
• Reduce energy consumption when the HP Photosmart is off
• Turn off the HP Photosmart

Work with print cartridges
To ensure the best print quality from the HP Photosmart, you will need to perform some
simple maintenance procedures and, when prompted by a message on the display,
replace the print cartridges.

This section contains the following topics:

• Handle the print cartridges
• Replace the print cartridges
• Print a self-test report
• Check the estimated ink levels
• Use a photo print cartridge
• Use the print cartridge protector
• Align the print cartridges
• Clean the print cartridges
• Clean the print cartridge contacts
• Clean the area around the ink nozzles
• Remove ink from your skin and clothing
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Handle the print cartridges
Before you replace or clean a print cartridge, you should know the part names and how
to handle the print cartridges.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Hold the print cartridges by their black plastic sides, with the label on top. Do not touch
the copper-colored contacts or the ink nozzles.

NOTE: Handle the print cartridges carefully. Dropping or jarring cartridges can cause
temporary printing problems, or even permanent damage.

Replace the print cartridges
Follow these instructions when you need to replace print cartridges.

NOTE: When the ink level for the print cartridge is low, a message appears on the
display. You can also check the ink levels by using the Printer Toolbox available
through the HP Photosmart Software on your computer or through the Print
Properties dialog box on your computer.

If you do not already have replacement print cartridges for the HP Photosmart, go to
www.hp.com/buy/supplies. If prompted, choose your country/region, follow the prompts
to select your product, and then click one of the shopping links on the page.

NOTE: At this time, some portions of the HP Web site are available in English only.
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Choose the right cartridge combination
Choose the best combination of cartridges for your print job:

• Everyday printing: Use a black cartridge along with a tri-color cartridge.
• Color photos: Use a photo cartridge along with a tri-color cartridge.
• Black-and-white photos: Use a gray photo cartridge along with a tri-color cartridge.

To replace the print cartridges
1. Make sure the HP Photosmart is on.

CAUTION: If the HP Photosmart is off when you open the print cartridge door to
access the print cartridges, the HP Photosmart will not release the cartridges for
changing. You might damage the HP Photosmart if the print cartridges are not
docked safely when you try to remove them.

2. Open the print cartridge door.
The print carriage moves to the far right side of the HP Photosmart.

3. Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.
If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.
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If you are replacing the black, photo, or gray photo print cartridge, remove the print
cartridge from the slot on the right.

1 Print cartridge slot for the tri-color print cartridge

2 Print cartridge slot for the black and photo print cartridges

4. Pull the print cartridge toward you out of its slot.
5. If you are removing the black print cartridge in order to install the photo or gray photo

print cartridge, store the black print cartridge in the print cartridge protector or an
airtight plastic container.

6. Remove the new print cartridge from its packaging and, being careful to touch only
the black plastic, gently remove the plastic tape by using the pink pull tab.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

CAUTION: Do not touch the copper-colored contacts or ink nozzles. Also, do
not re-tape the print cartridges. Doing so can result in clogs, ink failure, and bad
electrical connections.
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7. Hold the print cartridge with the HP logo on top, and insert the new print cartridge into
the empty cartridge slot. Make sure you push the print cartridge in firmly until it snaps
into place.
If you are installing the tri-color print cartridge, slide it into the left slot.
If you are installing a black, photo, or gray photo print cartridge, slide it into the right
slot.

8. Close the print cartridge door.

If you installed a new print cartridge, the HP Photosmart prints a print cartridge
alignment page.

9. When prompted, ensure plain white paper is loaded in the input tray, then press
OK.
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10. The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.
Recycle or discard the page.
A success or failure message appears.

NOTE: If you have colored paper loaded in the input tray when you align the
printer, the alignment will fail. Load unused plain white paper into the input tray,
and then try the alignment again.

11. Press OK to continue.

Related topics
“Shop for ink supplies” on page 67

Print a self-test report
If you are experiencing problems with printing, print a self-test report before you replace
the print cartridges. This report provides useful information on several aspects of your
device, including your print cartridges.

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Red-Eye Removal button.

The HP Photosmart prints a self-test report, which might indicate the source of the
printing problem. A sample of the ink test area of the report is shown below.

3. Make sure the test patterns show a complete grid and the thick color lines are
complete.
• If more than a few lines in a pattern are broken, this might indicate a problem with

the nozzles. You might need to clean the print cartridges.
• If the black line is missing, faded, streaked, or shows lines, this might indicate a

problem with the black or photo print cartridge in the right slot.
• If any of the color lines are missing, faded, streaked, or show lines, this might

indicate a problem with the tri-color print cartridge in the left slot.
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Related topics
• “Clean the print cartridges” on page 62
• “Replace the print cartridges” on page 54
• “Align the print cartridges” on page 61

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to
replace a print cartridge. The ink supply level shows an estimate of the amount of ink
remaining in the print cartridges.

TIP: You can also print a self-test report to see if your print cartridges might need to
be replaced.

NOTE: The HP Photosmart can only detect the ink levels for genuine HP ink. The
ink levels in print cartridges that are refilled or have been used in other devices, might
not register accurately.

NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the device and cartridges
for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.

To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.

The estimated ink levels for the print cartridges appear.

Related topics
“Print a self-test report” on page 58

Use a photo print cartridge
You can optimize the quality of the color photos you print with the HP Photosmart by
purchasing a photo print cartridge. Remove the black print cartridge and insert the photo
print cartridge in its place. With the tri-color print cartridge and photo print cartridge
installed, you have a six-ink system, which provides enhanced quality color photos.

When you want to print regular text documents, swap the black print cartridge back in.
Use a print cartridge protector or an airtight plastic container to keep your print cartridge
secure when it is not being used.
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Related topics
• “Shop for ink supplies” on page 67
• “Replace the print cartridges” on page 54
• “Use the print cartridge protector” on page 60

Use the print cartridge protector
In some countries/regions, when you purchase a photo print cartridge, you might also
receive a print cartridge protector. In other countries/regions, a print cartridge protector
comes in the box with the HP Photosmart. If neither your print cartridge nor the
HP Photosmart came with a print cartridge protector, you can use an airtight plastic
container to protect your print cartridge.

The print cartridge protector is designed to keep a print cartridge secure and prevent it
from drying out when it is not being used. Whenever you remove a print cartridge from
the HP Photosmart with the intention of using it again later, store it in the print cartridge
protector. For example, store the black print cartridge in a print cartridge protector if you
are removing it so you can print high-quality photos with the photo and tri-color print
cartridges.

To insert a print cartridge into the print cartridge protector
▲ Place the print cartridge into the print cartridge protector at a slight angle and snap it

securely into place.
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To remove the print cartridge from the print cartridge protector
▲ Press down on the top of the print cartridge protector to release the print cartridge,

then gently remove the print cartridge out of the print cartridge protector.

Align the print cartridges
Aligning the print cartridges ensures high-quality output. The HP Photosmart prompts you
to align and calibrate the print cartridges every time you install a new print cartridge. Make
sure you align the print cartridges when prompted to ensure excellent print quality.

NOTE: If you remove and reinstall the same print cartridge, the HP Photosmart will
not prompt you to align the print cartridges. The HP Photosmart remembers the
alignment values for that print cartridge, so you do not need to realign the print
cartridges.

To align the print cartridges from the control panel when prompted
1. Make sure you have letter or A4 unused plain white paper loaded in the input tray,

and then press OK.
2. The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.

Recycle or discard the page.

NOTE: If you have colored paper loaded in the input tray when you align the
printer, the alignment will fail. Load unused plain white paper into the input tray,
and then try the alignment again.

To align the print cartridges from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
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3. Click the Device Services tab.
4. Click Align the Print Cartridges.

The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.
Recycle or discard the page.

Clean the print cartridges
Use this feature when the self-test report shows streaking, white lines through any of the
lines of color or when a color is muddy after installing a print cartridge for the first time.
Do not clean print cartridges unnecessarily, as this wastes ink and shortens the life of the
ink nozzles.

To clean the print cartridges from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Clean the Print Cartridges.
5. Follow the prompts until you are satisfied with the quality of the output, and then click

Done.
If print quality still seems poor after you clean the print cartridges, try cleaning the
print cartridge contacts before replacing the affected print cartridge.

Related topics
• “Clean the print cartridge contacts” on page 62
• “Replace the print cartridges” on page 54

Clean the print cartridge contacts
Clean the print cartridge contacts only if you get repeated messages on the display
prompting you to check a print cartridge after you already have cleaned or aligned the
print cartridges.

Before cleaning the print cartridge contacts, remove the print cartridge and verify that
nothing is covering the print cartridge contacts, then reinstall the print cartridge. If you
continue to get messages to check the print cartridges, clean the print cartridge contacts.
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Make sure you have the following materials available:

• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge
contacts. These can damage the print cartridge or the HP Photosmart.

To clean the print cartridge contacts
1. Turn on the HP Photosmart and open the print cartridge door.

The print carriage moves to the far right side of the HP Photosmart.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from

the back of the HP Photosmart.
3. Lightly press down on the print cartridge to release it, and then pull it towards you out

of the slot.

NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the
HP Photosmart for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any

excess water from it.
6. Hold the print cartridge by its sides.
7. Clean only the copper-colored contacts. Allow the print cartridges to dry for

approximately ten minutes.

1 Copper-colored contacts

2 Ink nozzles (do not clean)

8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.
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9. Repeat if necessary for the other print cartridge.
10. Gently close the print cartridge door and plug the power cord into the back of the

HP Photosmart.

Related topics
“Clean the area around the ink nozzles” on page 64

Clean the area around the ink nozzles
If the HP Photosmart is used in a dusty environment, a small amount of debris might
accumulate inside the device. This debris can include dust, hair, carpet, or clothing fibers.
When debris gets on the print cartridges, it can cause ink streaks and smudges on printed
pages. Ink streaking can be corrected by cleaning around the ink nozzles as described
here.

NOTE: Clean the area around the ink nozzles only if you continue to see streaks
and smudges on your printed pages after you have already cleaned the print
cartridges by using the control panel or the software you installed with the
HP Photosmart.

Make sure you have the following materials available:

• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

To clean the area around the ink nozzles
1. Turn on the HP Photosmart and open the print cartridge door.

The print carriage moves to the far right side of the HP Photosmart.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from

the back of the HP Photosmart.
3. Lightly press down on the print cartridge to release it, and then pull it towards you out

of the slot.

NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the
HP Photosmart for more than 30 minutes.

4. Place the print cartridge on a piece of paper with the ink nozzles facing up.
5. Lightly moisten a clean foam rubber swab with distilled water.
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6. Clean the face and edges around the ink nozzle area with the swab, as shown below.

1 Nozzle plate (do not clean)

2 Face and edges around the ink nozzle area

CAUTION: Do not clean the nozzle plate.

7. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

8. Repeat if necessary for the other print cartridge.
9. Gently close the print cartridge door and plug the power cord into the back of the

HP Photosmart.

Related topics
“Clean the print cartridges” on page 62

Remove ink from your skin and clothing
Follow these instructions to remove ink from your skin and clothing:

Surface Remedy

Skin Wash the area with an abrasive soap.

White fabric Wash the fabric in cold water and use chlorine bleach.

Color fabric Wash the fabric in cold water and use sudsy ammonia.

CAUTION: Always use cold water to remove ink from fabric. Warm or hot water can
set the ink into the fabric.

Clean the HP Photosmart
Use a soft cloth or slightly moistened sponge to wipe dust, smudges, and stains off the
case. The interior of the HP Photosmart does not require cleaning. Keep fluids away from
the control panel and the interior of the HP Photosmart.

CAUTION: To avoid damage to the exterior of the HP Photosmart, do not use
alcohol or alcohol-based cleaning products.
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TIP: You can purchase an HP Cleaning Kit for Inkjet Printers and All-in-Ones
(Q6260A) that provides everything needed to safely clean your HP device. For more
information, go to: www.shopping.hp.com/accessories-store/printer.

Reduce energy consumption when the HP Photosmart is
off

When the HP Photosmart is off, an amount of energy is still being consumed. Energy
consumption can be lessened by enabling the Standby/Off state.

NOTE: When the HP Photosmart is in the Standby/Off state, it will take longer than
usual to turn back on.

To enable the Standby/Off state
▲ Press and hold the On button for 3 seconds until the HP Photosmart turns off.

Turn off the HP Photosmart
To avoid damaging the HP Photosmart, you must properly shut it down by using the
On button located on the device. Do not turn the HP Photosmart off by unplugging the
power cord or turning off a power strip.
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10 Shop for ink supplies
For a list of print cartridge numbers, see the printed documentation that came with the
HP Photosmart. You can also use the software that came with the HP Photosmart to find
out the reorder number for all the print cartridges. You can order print cartridges online
from the HP Web site. Additionally, you can contact a local HP reseller to find out the
correct print cartridge reorder numbers for your device and purchase print cartridges.

To order genuine HP supplies for the HP Photosmart, go to www.hp.com/buy/supplies.
If prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

NOTE: Ordering print cartridges online is not supported in all countries/regions. If it
is not supported in your country/region, contact a local HP reseller for information
about purchasing print cartridges.

To order print cartridges from your desktop
▲ Click the Shop for HP Supplies icon on your desktop to connect to HP SureSupply.

You will see a list of original HP printing supplies that are compatible with your device,
as well as options to conveniently purchase the supplies you need (options vary by
country/region).
If you deleted this icon from your desktop, click the Start menu, point to the HP folder,
then click Shop for Supplies.

To order print cartridges through the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

2. Click the Estimated Ink Levels tab.
3. Click Print Cartridge Ordering Information.

The print cartridge reorder numbers appear.
4. Click Order Online.

HP sends detailed printer information, including model number, serial number, and
ink supply levels, to an authorized online reseller. The supplies you need are
preselected; you can change quantities, add or remove items, and then check out.
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11 Troubleshooting
This section contains the following topics:

• Troubleshooting tips
• Hardware setup troubleshooting
• Software installation troubleshooting
• Print quality troubleshooting
• Print troubleshooting
• Memory card troubleshooting
• CD/DVD print troubleshooting
• Errors

Troubleshooting tips
This section contains the following topics:

• Communication problems over a USB connection
• Information on paper
• Information on print cartridges
• Clear paper jams
• Troubleshoot print cartridges

Communication problems over a USB connection

NOTE: For information on communication problems involving a memory card, see
“Memory card troubleshooting” on page 102.

If the HP Photosmart and computer are USB-connected and are not communicating with
each other, try the following:

• Look at the display on the HP Photosmart. If the display is blank and the On button
is not lit, the HP Photosmart is turned off. Make sure the power cord is firmly
connected to the HP Photosmart and plugged into a power outlet. Press the On button
to turn on the HP Photosmart.

• Check the USB cable. If you are using an older cable, it might not be working properly.
Try connecting it to another product to see if the USB cable works. If you experience
problems, the USB cable might need to be replaced. Also verify that the cable does
not exceed 3 meters (9.8 feet) in length.

• Check the connection from the HP Photosmart to your computer. Verify that the USB
cable is securely plugged into the USB port on the back of the HP Photosmart. Make
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sure the other end of the USB cable is plugged into a USB port on your computer.
After the cable is connected properly, turn the HP Photosmart off and then on again.

• If you are connecting the HP Photosmart through a USB hub, make sure the hub is
turned on. If the hub is on, try connecting directly to your computer.

• Check other printers or scanners. You might need to disconnect older products from
your computer.

• Try connecting the USB cable to another USB port on your computer. After you check
the connections, try restarting your computer. Turn the HP Photosmart off and then
on again.

• If necessary, remove the software you installed with the HP Photosmart and then
install it again.

For more information, see:

“Uninstall and reinstall the software” on page 85

Information on paper
The HP Photosmart is designed to work well with most paper types. Test a variety of
paper types before buying a large quantity. Find a paper type that works well and is easy
to purchase. HP Premium papers are designed for the best quality results. In addition,
follow these tips:

• Do not use paper that is too thin, that has a slick texture, or that stretches easily. It
can feed incorrectly through the paper path, causing paper jams.

• Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag.

• Always hold photo paper by the edges. Fingerprints on photo paper can reduce print
quality.

• Do not use paper that is heavily textured. It can cause graphics or text to print
improperly.
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• Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

• Store printed photos under glass or in a storage book to prevent bleeding over time
from high humidity. Use HP Premium Plus photo paper for maximum performance.

Information on print cartridges
For best results, use HP print cartridges. Refilled print cartridges might damage the
HP Photosmart. The following tips help maintain HP print cartridges and ensure
consistent print quality.
• Keep all print cartridges in the original sealed packages until they are needed.
• Store print cartridges at room temperature (15.6°-26.6° C or 60°-78° F).
• Do not reattach the protective tape once it has been removed from the print cartridge.

Reattaching the plastic tape might damage the print cartridge. Place the print cartridge
in the HP Photosmart immediately after removing the plastic tape. If this is not
possible, store it in a print cartridge protector or airtight plastic container.

• HP recommends that you do not remove the print cartridges from the HP Photosmart
until you have replacement print cartridges available to install.

• Turn off the HP Photosmart from the control panel. Do not turn off the device by turning
off a power strip or unplugging the power cord from the HP Photosmart. If you
improperly turn off the HP Photosmart, the print carriage does not return to the correct
position and the print cartridges can dry out.

• Do not open the print cartridge door unless necessary. This exposes the print
cartridges to air, which reduces the life of the print cartridges.

NOTE: If you leave the print cartridge door open for a long period of time, the
HP Photosmart will recap the print cartridges to protect them from exposure to
air.

• Clean the print cartridges when you notice a significant decrease in print quality.

TIP: You might notice a decrease in print quality if the print cartridges have not
been used for a long time.

• Do not clean the print cartridges unnecessarily. This wastes ink and shortens the life
of the cartridges.

• Handle print cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems. If print quality is poor right after
cartridge installation, allow half an hour for the print cartridge to recover.

For more information, see:

“Troubleshoot print cartridges” on page 74

Clear paper jams
If the HP Photosmart has a paper jam, check the Two-sided printing accessory. If paper
is still jammed, check the front door.
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To clear a paper jam from the Two-sided printing accessory
1. Turn off the HP Photosmart.
2. Press in the tabs on the left and right side of the Two-sided printing accessory.

Remove the accessory by pulling it away from the HP Photosmart.

CAUTION: Trying to clear a paper jam from the front of the HP Photosmart can
damage the print mechanism. Always access and clear paper jams from the Two-
sided printing accessory of the HP Photosmart.

3. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside the
device. If you do not remove all the pieces of paper from the HP Photosmart, more
paper jams are likely to occur.

4. If the paper jam is cleared, proceed to step 5.
If the paper jam is not cleared, do the following:
a. Open the Two-sided printing accessory by squeezing the tabs together.
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b. Remove any paper from inside the accessory.
c. Close the Two-sided printing accessory cover until it locks into place.

5. Replace the Two-sided printing accessory. Gently push the accessory forward until
it snaps into place.

6. Turn on the HP Photosmart, and then press OK to continue the current job.

To clear a paper jam from the front door
1. If necessary, raise the output tray. Then, raise the print cartridge door.

2. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside the
device. If you do not remove all the pieces of paper from the HP Photosmart, more
paper jams are likely to occur.

3. Lower the print cartridge door. Also, lower the output tray if it is raised.
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4. Press OK to continue the current job.

Troubleshoot print cartridges
If you are experiencing problems with printing, you might have a problem with one of the
print cartridges. Do the following:

To troubleshoot print cartridges
1. Remove the black print cartridge from the slot on the right. Do not touch the ink

nozzles or the copper-colored contacts. Check for possible damage to the copper-
colored contacts or ink nozzles.
Make sure the clear plastic tape has been removed. If it is still covering the ink nozzles,
gently remove the clear plastic tape by using the pink pull tab. Make sure you do not
remove the copper colored tape containing the electrical contacts.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

2. Reinsert the print cartridge by sliding it forward into the slot. Then push the print
cartridge forward until it clicks into the socket.

3. Repeat steps 1 and 2 for the tri-color print cartridge on the left side.

Chapter 11

74 Troubleshooting

Troubleshooting



4. If the problem persists, print a self-test report to determine if there is a problem with
the print cartridges.
This report provides useful information about your print cartridges, including status
information.

5. If the self-test report shows a problem, clean the print cartridges.
6. If the problem persists, clean the copper-colored contacts of the print cartridges.
7. If you are still experiencing problems with printing, determine which print cartridge is

experiencing the problem and replace it.

To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.

The estimated ink levels for the print cartridges appear.

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Red-Eye Removal button.

The HP Photosmart prints a self-test report, which might indicate the source of the
printing problem. A sample of the ink test area of the report is shown below.

3. Make sure the test patterns show a complete grid and the thick color lines are
complete.
• If more than a few lines in a pattern are broken, this might indicate a problem with

the nozzles. You might need to clean the print cartridges.
• If the black line is missing, faded, streaked, or shows lines, this might indicate a

problem with the black or photo print cartridge in the right slot.
• If any of the color lines are missing, faded, streaked, or show lines, this might

indicate a problem with the tri-color print cartridge in the left slot.
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To clean the print cartridges from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click

Printer Toolbox.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.

The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Clean the Print Cartridges.
5. Follow the prompts until you are satisfied with the quality of the output, and then click

Done.
If print quality still seems poor after you clean the print cartridges, try cleaning the
print cartridge contacts before replacing the affected print cartridge.

To clean the print cartridge contacts
1. Turn on the HP Photosmart and open the print cartridge door.

The print carriage moves to the far right side of the HP Photosmart.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from

the back of the HP Photosmart.
3. Lightly press down on the print cartridge to release it, and then pull it towards you out

of the slot.

NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the
HP Photosmart for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any

excess water from it.
6. Hold the print cartridge by its sides.
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7. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes.

1 Copper-colored contacts

2 Ink nozzles (do not clean)

8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

9. Repeat if necessary for the other print cartridge.
10. Gently close the print cartridge door and plug the power cord into the back of the

HP Photosmart.

To replace the print cartridges
1. Make sure the HP Photosmart is on.

CAUTION: If the HP Photosmart is off when you open the print cartridge door to
access the print cartridges, the HP Photosmart will not release the cartridges for
changing. You might damage the HP Photosmart if the print cartridges are not
docked safely when you try to remove them.

2. Open the print cartridge door.
The print carriage moves to the far right side of the HP Photosmart.
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3. Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.
If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.
If you are replacing the black, photo, or gray photo print cartridge, remove the print
cartridge from the slot on the right.

1 Print cartridge slot for the tri-color print cartridge

2 Print cartridge slot for the black and photo print cartridges

4. Pull the print cartridge toward you out of its slot.
5. If you are removing the black print cartridge in order to install the photo or gray photo

print cartridge, store the black print cartridge in the print cartridge protector or an
airtight plastic container.

6. Remove the new print cartridge from its packaging and, being careful to touch only
the black plastic, gently remove the plastic tape by using the pink pull tab.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

CAUTION: Do not touch the copper-colored contacts or ink nozzles. Also, do
not re-tape the print cartridges. Doing so can result in clogs, ink failure, and bad
electrical connections.
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7. Hold the print cartridge with the HP logo on top, and insert the new print cartridge into
the empty cartridge slot. Make sure you push the print cartridge in firmly until it snaps
into place.
If you are installing the tri-color print cartridge, slide it into the left slot.
If you are installing a black, photo, or gray photo print cartridge, slide it into the right
slot.

8. Close the print cartridge door.

If you installed a new print cartridge, the HP Photosmart prints a print cartridge
alignment page.

9. When prompted, ensure plain white paper is loaded in the input tray, then press
OK.
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10. The HP Photosmart prints a test page, aligns the print head, and calibrates the printer.
Recycle or discard the page.
A success or failure message appears.

NOTE: If you have colored paper loaded in the input tray when you align the
printer, the alignment will fail. Load unused plain white paper into the input tray,
and then try the alignment again.

11. Press OK to continue.

Hardware setup troubleshooting
This section contains hardware troubleshooting information for the HP Photosmart.

Many issues are caused when the HP Photosmart is connected to the computer using a
USB cable before the HP Photosmart software is installed on the computer. If you
connected the HP Photosmart to your computer before the software installation screen
prompts you to do so, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
3. Restart your computer.
4. Turn off the HP Photosmart, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.

This section contains the following topics:

• The HP Photosmart will not turn on
• I connected the USB cable, but I am having problems using the HP Photosmart with

my computer
• The HP Photosmart does not print

The HP Photosmart will not turn on
Cause: The HP Photosmart is not properly connected to a power supply.
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Solution:
• Make sure the power cord is firmly connected to both the HP Photosmart and the

power adapter. Plug the power cord into a grounded power outlet, surge protector,
or power strip.

1 Power connection

2 Power cord and adapter

3 Grounded power outlet

• If you are using a power strip, make sure the power strip is on. Or, try plugging
the HP Photosmart directly into a grounded power outlet.

• Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.

• If you plugged the HP Photosmart into a switched outlet, make sure the switch is
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: You pressed the On button too quickly.

Solution: The HP Photosmart might not respond if you press the On button too
quickly. Press the On button once. It might take a few minutes for the HP Photosmart
to turn on. If you press the On button again during this time, you might turn the device
off.

CAUTION: If the HP Photosmart still does not turn on, it might have a mechanical
failure. Unplug the HP Photosmart from the power outlet and contact HP. Go to:
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

I connected the USB cable, but I am having problems using the HP Photosmart with
my computer

Cause: The USB cable was connected before the software was installed.
Connecting the USB cable before prompted can cause errors.
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Solution: You must first install the software that came with the HP Photosmart
before connecting the USB cable. During installation, do not plug in the USB cable
until prompted by the onscreen instructions.

Once you have installed the software, connecting your computer to the
HP Photosmart with a USB cable is straightforward. Simply plug one end of the USB
cable into the back of your computer and the other into the back of the HP Photosmart.
You can connect to any USB port on the back of your computer.

For more information on installing the software and connecting the USB cable, see
the Setup Guide that came with the HP Photosmart.

The HP Photosmart does not print
Cause: The HP Photosmart and computer are not communicating with each other.
Solution: Check the connection between the HP Photosmart and computer.

For more information, see:

“Communication problems over a USB connection” on page 69

Cause: There might be a problem with one or more of the print cartridges.
Solution: Check that the print cartridges are installed properly and have ink.

For more information, see:

“Work with print cartridges” on page 53

Cause: The HP Photosmart might not be turned on.

Solution: Look at the display on the HP Photosmart. If the display is blank and the
On button is not lit, the HP Photosmart is turned off. Make sure the power cord is
firmly connected to the HP Photosmart and plugged into a power outlet. Press the
On button to turn on the HP Photosmart.

Cause: The HP Photosmart might be out of paper.
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Solution: Load paper in the input tray.

For more information, see:

“Load paper” on page 17

Software installation troubleshooting
Use this section to solve any problems you might encounter while setting up the
HP Photosmart software.

This section contains the following topics:
• When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
• The minimum system checks screen appears
• A red X appears on the USB connect prompt
• I received a message that an unknown error has occurred
• The registration screen does not appear
• Uninstall and reinstall the software
• Missing HP Photosmart Software

When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Cause: The installation failed to run automatically.

Solution: If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer
1. From the Windows Start menu, click Run (or click Accessories, and then Run).
2. In the Run dialog box, enter d:\setup.exe, and then click OK.

If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive
letter.

The minimum system checks screen appears
Cause: Your system does not meet the minimum requirements to install the
software.

Solution: Click Details to see what the specific problem is, and then correct the
problem before attempting to install the software.

A red X appears on the USB connect prompt
Cause: Normally, a green check appears indicating that the USB connection is
successful. A red X indicates that the USB connection failed.
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Solution: Check that the HP Photosmart is turned on, and then try the USB
connection again.

To retry the USB connection
1. Unplug the HP Photosmart power cord, and then plug it in again.
2. Verify that the USB cable and power cord are plugged in.

3. Click Retry to retry the connection. If this does not work, continue to the next step.
4. Verify that the USB cable is set up properly as follows:

• Unplug the USB cable and plug it in again or try plugging the USB cable into
a different USB port.

• Do not attach the USB cable to a keyboard.
• Verify that the USB cable is 3 meters (9.8 feet) or less in length.
• If you have several USB devices attached to your computer, you might want

to unplug the other devices during the installation.
5. Continue with the installation and restart the computer when prompted.

For more information, see:

“Uninstall and reinstall the software” on page 85

I received a message that an unknown error has occurred
Cause: The source of the error is unknown.

Solution: Try to continue with the installation. If that does not work, stop and then
restart the installation, and follow the directions on the screen. If an error occurs, you
might need to uninstall and then reinstall the software. Do not simply delete the
HP Photosmart application files from your computer. Make sure to remove them
properly using the uninstall utility provided when you installed the software that came
with the HP Photosmart.
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For more information, see:

“Uninstall and reinstall the software” on page 85

The registration screen does not appear
Cause: The registration screen did not launch automatically.

Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, Photosmart
D5300 series, and then clicking Product Registration.

Uninstall and reinstall the software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP Photosmart application files from your
computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP Photosmart.

To uninstall from a Windows computer, method 1
1. Disconnect the HP Photosmart from your computer. Do not connect the

HP Photosmart to your computer until after you have reinstalled the software.
2. On the Windows taskbar, click Start, Programs or All Programs, HP, Photosmart

D5300 series, Uninstall.
3. Follow the onscreen instructions.
4. If you are asked whether you would like to remove shared files, click No.

Other programs that use these files might not work properly if the files are deleted.
5. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

6. To reinstall the software, insert the HP Photosmart CD-ROM into your computer’s
CD-ROM drive, and follow the onscreen instructions and the instructions provided in
the Setup Guide that came with the HP Photosmart.

7. After the software is installed, connect the HP Photosmart to your computer.
8. Press the On button to turn the HP Photosmart on.

After connecting and turning on the HP Photosmart, you might have to wait several
minutes for all of the Plug and Play events to complete.

9. Follow the onscreen instructions.

To uninstall from a Windows computer, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.
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1. On the Windows taskbar, click Start, Settings, Control Panel (or just Control
Panel).

2. Double-click Add/Remove Programs (or click Uninstall a program).
3. Select HP Photosmart Printer Driver Software, and then click Change/Remove.

Follow the onscreen instructions.
4. Disconnect the HP Photosmart from your computer.
5. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

6. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

7. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the HP Photosmart.

To uninstall from a Windows computer, method 3

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

2. Disconnect the HP Photosmart from your computer.
3. Select Uninstall and follow the onscreen directions.
4. Restart your computer.

NOTE: It is important that you disconnect the HP Photosmart before restarting
your computer. Do not connect the HP Photosmart to your computer until after
you have reinstalled the software.

5. Start the Setup program for the HP Photosmart again.
6. Select Install.
7. Follow the onscreen instructions and the instructions provided in the Setup Guide that

came with the HP Photosmart.

Missing HP Photosmart Software
Cause: The HP Photosmart Software is not installed.

Solution: Install the HP Photosmart Software that came with the HP Photosmart.
If it is installed, restart your computer.

To install the HP Photosmart Software
1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then

start the Setup program.
2. When prompted, click Install More Software to install the HP Photosmart

Software.
3. Follow the onscreen instructions and the instructions provided in the Setup Guide

that came with the HP Photosmart.

Chapter 11

86 Troubleshooting

Troubleshooting



Cause: The HP Photosmart is turned off.

Solution: Turn the HP Photosmart on.

Cause: The computer is turned off.

Solution: Turn the computer on.

Cause: The HP Photosmart is not properly connected to the computer.

Solution: Check the connection from the HP Photosmart to your computer. Verify
that the USB cable is securely plugged into the USB port on the back of the
HP Photosmart. Make sure the other end of the USB cable is plugged into a USB port
on your computer. After the cable is connected properly, turn the HP Photosmart off
and then on again.

For more information on setting up the HP Photosmart and connecting it to your
computer, see the Setup Guide that came with the HP Photosmart.

Print quality troubleshooting
If you are having problems with print quality, try the solutions in this section and observe
the following guidelines:

• To achieve the best print quality, HP recommends using HP papers that are
specifically designed for the type of project you are printing along with genuine HP
ink. HP papers and HP ink are specifically designed to work well together to provide
high-quality output.

• Replace refilled or empty cartridges with genuine HP print cartridges.
• Check the device settings to make sure that the print mode and paper selection is

correct for the paper and the task.
For more information, see “Set the paper type for printing” on page 29 and “Choose
papers for printing” on page 15.

• Print and evaluate a self-test.
For more information, see “Print a self-test report” on page 58.
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If the self-test shows a defect, try the following:
• Clean the print cartridges automatically. For more information, see “Clean the

print cartridges” on page 62.
• If you are missing lines when you print, clean the electrical contacts. For more

information, see “Clean the print cartridge contacts” on page 62.
• Replace the print cartridge. For more information, see “Replace the print

cartridges” on page 54.
• If the self-test does not show a problem, investigate other causes, such as the image

file or software program.

For additional print cartridge troubleshooting, visit the HP Web site at www.hp.com/
support.

This section contains the following topics:

• Ink is bleeding or smearing
• Ink is not filling the text or graphics completely
• The text edges are jagged
• The printout has a horizontal band of distortion near the bottom of the page
• Colors run into each other on the printout
• Printouts have horizontal streaks or lines
• Printouts are faded or have dull colors
• Printouts seem blurry or fuzzy
• Printouts have vertical streaks
• Printouts are slanted or skewed
• Paper is not picked up from the input tray

Ink is bleeding or smearing
Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The print cartridges need to be cleaned.

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: The paper is too close to the print cartridge during printing.

Solution: If the paper is too close to the print cartridge during printing, the ink might
be smeared. This can happen if the paper is raised, wrinkled, or very thick, such as
a mailing envelope. Make sure the paper lays flat in the input tray and is not too
wrinkled.
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Ink is not filling the text or graphics completely
Cause: The Paper Type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:

“Set the paper type for printing” on page 29

Cause: The print quality setting on the HP Photosmart is set too low.
Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 70

Cause: The print cartridges need to be cleaned or might be out of ink.
Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: You are using non-HP ink.

Solution: HP recommends that you use genuine HP print cartridges. Genuine HP
print cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

The text edges are jagged
Cause: The font is a custom size.

Solution: Some software applications offer custom fonts that have jagged edges
when enlarged or printed. Also, if you want to print bitmapped text, it might have
jagged edges when enlarged or printed.
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Use TrueType or OpenType fonts to ensure that the HP Photosmart is able to print
smooth fonts. When selecting a font, look for the TrueType or OpenType icon.

The printout has a horizontal band of distortion near the bottom of the page
Cause: Your photo image has light blue, gray, or brown hues that print near the
bottom of the page.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page. Print the
image using six-ink printing. To do so, install the photo print cartridge in place of the
black print cartridge. With the photo print cartridge and the tri-color print cartridge
installed, you have a six-ink system, which provides enhanced quality photos.

For more information, see:

• “Information on paper” on page 70
• “Troubleshoot print cartridges” on page 74

Colors run into each other on the printout
Cause: The print quality setting is set too high for the type of paper loaded in the
HP Photosmart.

Solution: Check the quality setting. Use a lower quality setting to decrease the
amount of ink used for printing.

For more information, see:

“Change the print speed or quality” on page 30

Cause: The paper type is not suitable for the HP Photosmart.
Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: You are printing on the wrong side of the paper.

Solution: Load paper with the side you want to print on facing down. For example,
if you are loading glossy photo paper, load the paper with the glossy side down.

For more information, see:

“Load paper” on page 17

Cause: You are using non-HP ink.
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Solution: HP recommends that you use genuine HP print cartridges. Genuine HP
print cartridges are designed and tested with HP printers to help you easily produce
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable to
the use of non-HP ink will not be covered under warranty.

Cause: The print cartridges need to be cleaned.

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Printouts have horizontal streaks or lines
Cause: The paper is not feeding properly or is loaded incorrectly.

Solution: Make sure the paper is loaded correctly.

For more information, see:
“Load full-size paper” on page 18

Cause: The print quality setting on the HP Photosmart is set too low.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:
“Information on paper” on page 70

Cause: The print cartridges need to be cleaned or might be out of ink.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.
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Cause: A tri-color or photo print cartridge was jarred or handled roughly during
installation.

Solution: Allow half an hour for the print cartridge to recover.

Cause: There might be fiber or dust built up around the ink nozzle area on the print
cartridges.
Solution: Check the print cartridges. If it looks as though there are fibers or dust
around the ink nozzles, clean the ink nozzle area of the print cartridge.

For more information, see:

“Clean the print cartridge contacts” on page 62

Printouts are faded or have dull colors
Cause: The print quality setting on the HP Photosmart is set too low.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 70

Cause: The paper type is not suitable for the HP Photosmart.
Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The Paper Type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:

“Set the paper type for printing” on page 29

Cause: The print cartridges need to be cleaned or might be out of ink.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.
If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
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For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Printouts seem blurry or fuzzy
Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Cause: The Paper Type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.

For more information, see:

“Set the paper type for printing” on page 29

Cause: The print quality setting on the HP Photosmart is set too low.

Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

If the problem persists, use the software you installed with the HP Photosmart or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:

“Information on paper” on page 70

Cause: You are printing on the wrong side of the paper.

Solution: Load paper with the side you want to print on facing down. For example,
if you are loading glossy photo paper, load the paper with the glossy side down.

For more information, see:
“Load paper” on page 17

Printouts have vertical streaks
Cause: The paper type is not suitable for the HP Photosmart.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP Photosmart.

Printouts are slanted or skewed
Cause: The paper is not feeding properly or is loaded incorrectly.
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Solution: Make sure the paper is loaded correctly.

For more information, see:

“Load full-size paper” on page 18

Cause: More than one type of paper is loaded in the input tray.

Solution: Load only one type of paper at a time.

Cause: The Two-sided printing accessory might not be securely installed.
Solution: Make sure the Two-sided printing accessory on the back of the
HP Photosmart is securely installed.

Paper is not picked up from the input tray
Cause: There is not enough paper in the input tray.

Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:

“Load full-size paper” on page 18

Print troubleshooting
Use this section to solve these printing problems:

• Envelopes print incorrectly
• Borderless printing produces unexpected results
• The HP Photosmart is not responding
• The HP Photosmart prints meaningless characters
• Nothing happens when I try to print
• The pages in my document came out in the wrong order
• The margins are not printing as expected
• Text or graphics are cut off at the edge of the page
• A blank page came out while printing
• Ink is spraying the inside of the HP Photosmart when I print a photo

Envelopes print incorrectly
Cause: A stack of envelopes is loaded incorrectly.

Solution: Remove all paper from the main input tray. Load a stack of envelopes in
the main input tray, with the envelope flaps facing up and to the left.

NOTE: To avoid paper jams, tuck the flaps inside the envelopes.
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Cause: The wrong type of envelope is loaded.

Solution: Do not use shiny or embossed envelopes or envelopes that have clasps
or windows.

Borderless printing produces unexpected results
Cause: Printing a borderless image from a non-HP software application produces
unexpected results.

Solution: Try printing the image from the photo imaging software that came with
the HP Photosmart.

The HP Photosmart is not responding
Cause: The HP Photosmart is busy with another task.

Solution: Some documents take a long time to print. If nothing has printed several
minutes after you sent a print job to the HP Photosmart, check your computer to see
if there are any messages.

Cause: The HP Photosmart has a paper jam.

Solution: Clear the paper jam.

For more information, see:

“Clear paper jams” on page 71

Cause: The HP Photosmart is out of paper.

Solution: Load paper in the input tray.

For more information, see:

“Load paper” on page 17

Cause: The print carriage has stalled.

Solution: Turn the HP Photosmart off and open the print cartridge door. Remove
any objects that are blocking the print carriage (including any packing materials), and
then turn the HP Photosmart on again.

Cause: The computer is not communicating with the HP Photosmart.
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Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the
HP Photosmart and the computer as shown below.

If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP Photosmart, check the status of the HP Photosmart. In the
HP Photosmart Software, click Status.

For more information, see:

“Communication problems over a USB connection” on page 69

Cause: The HP Photosmart is turned off.

Solution: Look at the On button located on the top of the HP Photosmart. If it is not
lit, the HP Photosmart is turned off. Make sure the power cord is firmly connected to
the HP Photosmart and plugged into a power outlet. Press the On button to turn on
the HP Photosmart.

Cause: The HP Photosmart experienced an error.

Solution: Turn the HP Photosmart off, and then unplug the power cord. Plug the
power cord back in, and then press the On button to turn on the HP Photosmart.

Cause: The status of the printer driver has changed.

Solution: The printer driver status might have changed to either offline or stop
printing.

To check the printer driver status
1. In the HP Solution Center, click the device tab.
2. Click Settings.
3. Click Status.

If the status is offline or stop printing, change the status to ready.

Cause: A deleted print job is still in the queue.
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Solution: A print job might remain in the queue after it has been cancelled. The
cancelled print job jams the queue and prevents the next print job from printing.

From your computer, open the printer folder and see if the cancelled job remains in
the print queue. Try to delete the job from the queue. If the print job remains in the
queue, try one or both of the following:

• Disconnect the USB cable from the HP Photosmart, restart the computer, and
then reconnect the USB cable to the HP Photosmart.

• Shut down the HP Photosmart, restart the computer, and then restart the
HP Photosmart.

Cause: The Two-sided printing accessory is not installed correctly.

Solution: If the Two-sided printing accessory is installed, remove it and reinstall it.
To reinstall it, press the buttons on each side of the accessory and push it into the
rear of the HP Photosmart until it clicks into place.

If the Two-sided printing accessory is not installed, install it at the rear of the
HP Photosmart.

The HP Photosmart prints meaningless characters
Cause: There is no more available memory in the HP Photosmart.

Solution: Turn off the HP Photosmart and your computer for 60 seconds, then turn
them both on and try printing again.

Cause: The document is corrupt.
Solution: Try printing another document from the same software application. If this
works, then try printing a previously saved version of the document that is not corrupt.

Nothing happens when I try to print
Cause: The HP Photosmart is turned off.

Solution: Look at the On button located on the top of the HP Photosmart. If it is not
lit, the HP Photosmart is turned off. Make sure the power cord is firmly connected to
the HP Photosmart and plugged into a power outlet. Press the On button to turn on
the HP Photosmart.

Cause: The HP Photosmart is busy with another task.

Solution: Some documents take a long time to print. If nothing has printed several
minutes after you sent a print job to the HP Photosmart, check your computer to see
if there are any messages.

Cause: The HP Photosmart is not the selected printer.

Solution: Make sure the HP Photosmart is the selected printer in your software
application.
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TIP: You can set the HP Photosmart as the default printer to ensure that the
printer is automatically selected when you select Print in the File menu of your
different software applications.

Cause: The computer is not communicating with the HP Photosmart.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the
HP Photosmart and the computer as shown below.

If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP Photosmart, check the status of the HP Photosmart. In the
HP Photosmart Software, click Status.

For more information, see:

“Communication problems over a USB connection” on page 69

Cause: The HP Photosmart has a paper jam.

Solution: Clear the paper jam.
For more information, see:

“Clear paper jams” on page 71

Cause: The HP Photosmart is out of paper.

Solution: Load paper in the input tray.

For more information, see:

“Load paper” on page 17

Cause: The print carriage has stalled.
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Solution: Turn the HP Photosmart off and open the print cartridge door. Remove
any objects that are blocking the print carriage (including any packing materials), and
then turn the HP Photosmart on again.

The pages in my document came out in the wrong order
Cause: The print settings are set to print the first page of your document first.
Because of the way the paper feeds through the HP Photosmart, this means the first
page will be print side up at the bottom of the stack.

Solution: Print the document in reverse order. When the document finishes
printing, the pages will be in correct order.

For more information, see:

“Print a multiple-page document in reverse order” on page 40

The margins are not printing as expected
Cause: The margins are not set correctly in your software application.

Solution: Check the printer margins.

Make sure the margin settings for the document do not exceed the printable area of
the HP Photosmart.

To check your margin settings
1. Preview your print job before sending it to the HP Photosmart.
2. Check the margins.

The HP Photosmart uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP Photosmart
supports.

3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.

Cause: The paper size setting might not be set correctly for the project you are
printing.

Solution: Verify that you have selected the proper paper size setting for your
project. Make sure that you have loaded the correct paper size in the input tray.

Cause: The paper guides are not positioned correctly.

Solution: Remove the stack of paper from the input tray, reload the paper, and then
slide the paper width guide inward until it stops at the edge of the paper.

For more information, see:

“Load paper” on page 17

Cause: A stack of envelopes is loaded incorrectly.

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.
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NOTE: To avoid paper jams, tuck the flaps inside the envelopes.

For more information, see:

“Load envelopes” on page 21

Text or graphics are cut off at the edge of the page
Cause: The margins are not set correctly in your software application.

Solution:

To check your margin settings
1. Preview your print job before sending it to the HP Photosmart.
2. Check the margins.

The HP Photosmart uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP Photosmart
supports.

3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.

Make sure the margin settings for the document do not exceed the printable area of
the HP Photosmart.

Cause: The size of the document you are printing is larger than the paper loaded
in the input tray.

Solution: Make sure the layout of the document you are trying to print fits on a paper
size supported by the HP Photosmart.

To preview the print layout
1. Load the correct paper size into the input tray.
2. Preview your print job before sending it to the HP Photosmart.
3. Check the graphics in the document to make sure that the current size fits within

the printable area of the HP Photosmart.
4. Cancel the print job if the graphics do not fit in the printable area of the page.
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TIP: Some software applications allow you to scale the document to fit the paper
size currently selected. Additionally, you can scale the size of a document from
the print Properties dialog box.

Cause: The paper is loaded incorrectly.

Solution: If the paper is misfeeding, it could cause parts of the document to cut off.

Remove the stack of paper from the input tray, and then reload the paper following
the steps below.
For more information, see:

“Load paper” on page 17

A blank page came out while printing
Cause: If you are printing black text, and a blank page comes out of the
HP Photosmart, the black print cartridge might be empty.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: The document you are printing contains an additional blank page.

Solution: Open the document file in your software application and remove any extra
pages or lines at the end of the document.

Cause: The HP Photosmart picked up two sheets of paper.

Solution: If the HP Photosmart has only a few sheets remaining, load more paper
in the input tray. If there is plenty of paper in the input tray, remove the paper, tap the
stack of paper against a flat surface, and reload the paper into the input tray.

For more information, see:

“Load paper” on page 17

Cause: The protective plastic tape was only partially removed from the print
cartridge.

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
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covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Ink is spraying the inside of the HP Photosmart when I print a photo
Cause: The borderless print settings require photo paper to be loaded in the photo
tray. You are using the wrong paper type.

Solution: Make sure you load photo paper in the photo tray before you print a
borderless print job.

Memory card troubleshooting
Use this section to solve these memory card problems:

• My memory card no longer works in my digital camera
• The HP Photosmart does not read the memory card
• The Photo light next to the memory card slots is blinking
• The Attention light blinks when I insert my memory card
• The photos on the memory card do not transfer to my computer

My memory card no longer works in my digital camera
Cause: You formatted the card on a Windows XP computer. By default, Windows
XP will format a memory card of 8 MB or less and 64 MB or more with the FAT32
format. Digital cameras and other devices use the FAT (FAT16 or FAT12) format and
cannot recognize a FAT32 formatted card.
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Solution: Reformat your memory card in your camera or format your memory card
in a Windows XP computer by selecting the FAT format.

The HP Photosmart does not read the memory card
Cause: The card is inserted backwards or upside down.
Solution: Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.
If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Cause: The memory card is not fully inserted.

Solution: Make sure you fully insert the memory card into the appropriate slot on
the HP Photosmart.
If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After a memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Cause: You have inserted more than one memory card into the memory card slots.

Solution: If you have inserted more than one memory card, remove one of the
memory cards. You can use only one memory card at a time.

Cause: The file system is corrupted.

Solution: Check the computer screen for an error message telling you that the
images on the memory card are corrupted.

If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

The Photo light next to the memory card slots is blinking
Cause: The HP Photosmart is reading the memory card.

Solution: Do not pull out the memory card while the Photo light is flashing. A
flashing light means the HP Photosmart is accessing the memory card. Wait until the
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light remains solid. Removing a memory card while it is being accessed might corrupt
information on the card or damage the HP Photosmart and card.

The Attention light blinks when I insert my memory card
Cause: The HP Photosmart has detected an error with the memory card.
Solution: Remove and reinsert the memory card. You might have inserted it
incorrectly. Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.

If the problem continues, the memory card might be defective.

Cause: You have inserted more than one memory card.

Solution: Remove one of the memory cards. You can use only one memory card
at a time.

The photos on the memory card do not transfer to my computer
Cause: The HP Photosmart Software is not installed.

Solution: Install the HP Photosmart Software that came with the HP Photosmart.
If it is installed, restart your computer.

To install the HP Photosmart Software
1. Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then

start the Setup program.
2. When prompted, click Install More Software to install the HP Photosmart

Software.
3. Follow the onscreen instructions and the instructions provided in the Setup Guide

that came with the HP Photosmart.

Cause: The HP Photosmart is turned off.

Solution: Turn the HP Photosmart on.

Cause: The computer is turned off.

Solution: Turn the computer on.

Cause: The HP Photosmart is not properly connected to the computer.

Solution: Check the connection from the HP Photosmart to your computer. Verify
that the USB cable is securely plugged into the USB port on the back of the
HP Photosmart. Make sure the other end of the USB cable is plugged into a USB port

Chapter 11

104 Troubleshooting

Troubleshooting



on your computer. After the cable is connected properly, turn the HP Photosmart off
and then on again.

For more information on setting up the HP Photosmart and connecting it to your
computer, see the Setup Guide that came with the HP Photosmart.

CD/DVD print troubleshooting
Use this section to solve any problems you might encounter while printing on CD/DVD
surfaces with the HP Photosmart.

This section contains the following topics:

• The HP Photosmart does not detect the CD/DVD holder
• The HP Photosmart does not detect a CD/DVD on the holder
• The HP Photosmart stalled while printing a CD/DVD
• The image on my printed disc is cropped and there is ink on the CD/DVD holder
• The HP Photosmart is printing on a non-printable area of my disc
• The design is not centered on my disc
• The ink on the CD/DVD is not drying
• The HP Photosmart reports a CD/DVD size mismatch error
• The CD/DVD holder is stuck in the storage area

The HP Photosmart does not detect the CD/DVD holder
Cause: You might not have pushed the CD/DVD holder far enough into the CD/
DVD tray.
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Solution: Push the CD/DVD holder forward into the CD/DVD tray until the lines on
the holder line up to the white lines on the tray. The end of the holder marked with
arrows goes into the CD/DVD tray first.

Cause: You might have inserted the CD/DVD holder back into the storage area.

Solution: Remove the CD/DVD holder from the storage area below the main input
tray. Lower the CD/DVD tray (located below the control panel).

Make sure you loaded a printable disc onto the CD/DVD holder with the printable side
up. Push the CD/DVD holder forward into the CD/DVD tray until the lines on the holder
line up to the white lines on the tray. The end of the holder marked with arrows goes
into the CD/DVD tray first.

Cause: You might have inserted the disc directly into the CD/DVD tray without
placing it on the CD/DVD holder.

Solution: Remove the CD/DVD holder from the storage area below the main input
tray. Remove the printable disc from the CD/DVD tray and load it onto the CD/DVD
holder with the printable side up. Push the holder forward into the CD/DVD tray until
the lines on the holder line up to the white lines on the tray. The end of the holder
marked with arrows goes into the CD/DVD tray first.

Cause: The HP Photosmart prompts you to insert the next disc when printing
multiple CD/DVDs in a print job.

Solution: Remove the CD/DVD holder from the CD/DVD tray. Remove the printed
CD/DVD from the holder. Load the next disc onto the CD/DVD holder with the
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printable side up and reinsert the holder into the CD/DVD tray until the lines on the
holder line up to the white lines on the tray. When the HP Photosmart detects the
holder, the prompt disappears.

The HP Photosmart does not detect a CD/DVD on the holder
Cause: You inserted the CD/DVD holder into the CD/DVD tray without loading a
CD/DVD onto the holder.

Solution: Remove the CD/DVD holder from the CD/DVD tray. Load a printable disc
onto the CD/DVD holder with the printable side up and reinsert the holder into the
CD/DVD tray until the lines on the holder line up to the white lines on the tray.

Cause: You might have loaded the CD/DVD upside down on the holder.

Solution: Remove the CD/DVD holder from the CD/DVD tray. Load a printable disc
onto the CD/DVD holder with the printable side up and reinsert the holder into the
CD/DVD tray until the lines on the holder line up to the white lines on the tray.

The HP Photosmart stalled while printing a CD/DVD
Cause: The HP Photosmart pulls the CD/DVD holder through the device while
printing on the CD/DVD. The holder can protrude about 7.5 cm (3 inches) from the
back of the device. If there is not sufficient space behind the HP Photosmart, the
holder stops and printing stalls.

Solution: Ensure that there is at least 7.5 cm (3 inches) of space behind the
HP Photosmart. Also, make sure that the slot on the back of the HP Photosmart is
not blocked.

The image on my printed disc is cropped and there is ink on the CD/DVD holder
Cause: You loaded the CD/DVD onto the CD/DVD holder incorrectly.

Solution: If you are loading a regular-size (120 mm) CD/DVD onto the CD/DVD
holder to be printed, do not flip the blue ring over the disc. The blue ring should only
be used if you are printing on a small-size (80 mm) CD/DVD.

Before trying again, clean the CD/DVD holder to remove ink from the holder. This
avoids ink contamination within the device, as well as protects your discs, hands, and
clothing from stains later.

After the CD/DVD holder is clean and dry, load a new printable disc onto the holder
with the printable side up. Leave the blue ring in its original location on the opposite
side of the holder from your disc, as shown below. Reinsert the holder into the CD/
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DVD tray until the lines on the holder line up to the white lines on the tray and try your
print again.

The HP Photosmart is printing on a non-printable area of my disc
Cause: Your design is not the correct size for the CD/DVD you loaded.

Solution: Make sure the design you are printing is appropriate for the size of the
media loaded in the CD/DVD holder, including the diameter of the inner and outer
rings. Change the software settings accordingly to center and size your design for the
disc you are using. Refer to the documentation or the online help of the software you
are using for additional information.

Cause: You might have loaded the CD/DVD upside down on the holder.

Solution: If you have already burned your content onto the CD/DVD, you might
need to burn your contents again onto a new disc. Load the new disc onto the CD/
DVD holder with the printable side up. Reinsert the holder into the CD/DVD tray until
the lines on the holder line up to the white lines on the tray and try your print again.

The design is not centered on my disc
Cause: Your design settings might not be correct.

Solution: Change the software settings to center and size your design for the disc
you are using. Refer to the documentation or the online help of the software you are
using for additional information.

The ink on the CD/DVD is not drying
Cause: The surface of the disc is not compatible for printing.

Solution: Make sure that the CD/DVD you use is compatible for inkjet printing.
Inkjet printable discs normally have a white printing surface. (Some discs also have
a silver printing surface.)

Cause: You might have loaded the CD/DVD upside down on the holder.

Solution: If you have already burned your content onto the CD/DVD, you might
need to burn your contents again onto a new disc. Load the new disc onto the CD/
DVD holder with the printable side up. Reinsert the holder into the CD/DVD tray until
the lines on the holder line up to the white lines on the tray and try your print again.
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The HP Photosmart reports a CD/DVD size mismatch error
Cause: The size of the CD/DVD currently loaded on the CD/DVD holder does not
match the size you specified when you started the print job from the computer.
Solution: Cancel the print job and replace the CD/DVD currently loaded on the CD/
DVD holder with a CD/DVD that is the same size as specified in the print job, or
change the print settings in the software.

The CD/DVD holder is stuck in the storage area
Cause: You might have inserted the CD/DVD holder back into the storage area with
a CD/DVD loaded and the blue ring flipped over the disc.

Solution: Pull the CD/DVD holder out as far as possible, until you feel resistance.
Then, insert a flat blunt object (such as a butter knife or screwdriver) into the left corner
of the storage slot and push down on the blue ring. With the blue ring pressed down,
you should be able to pull the CD/DVD holder out of the storage slot.

Errors
This section contains the following categories of messages on your device:

• Device messages
• File messages
• General user messages
• Paper messages
• Power and connection messages
• Print cartridge messages

Device messages
The following is a list of device-related error messages:
• Carriage blocked
• Carriage jam
• Carriage stall
• Firmware revision mismatch
• Mechanism error
• CD/DVD tray open
• CD/DVD tray misaligned
• Insert CD/DVD holder
• Open CD/DVD tray
• CD/DVD holder not found
• CD/DVD not found
• Two-sided printing accessory is missing

Carriage blocked
Cause: The print carriage is blocked.
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Solution: Turn the HP Photosmart off and open the print cartridge door to access
the print carriage area. Remove any objects that are blocking the print carriage
(including any packing materials), and then turn the HP Photosmart on again.

Follow the prompts on the display to continue.

Cause: The CD/DVD tray is open.

Solution: Close the CD/DVD tray.

Carriage jam
Cause: The print carriage is blocked.

Solution: Turn the HP Photosmart off and open the print cartridge door to access
the print carriage area. Remove any objects that are blocking the print carriage
(including any packing materials), and then turn the HP Photosmart on again.

Follow the prompts on the display to continue.

Carriage stall
Cause: The print carriage is blocked.
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Solution: Turn the HP Photosmart off and open the print cartridge door to access
the print carriage area. Remove any objects that are blocking the print carriage
(including any packing materials), and then turn the HP Photosmart on again.

Follow the prompts on the display to continue.

Firmware revision mismatch
Cause: The revision number of the HP Photosmart firmware does not match the
revision number of the software.

Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Mechanism error
Cause: The HP Photosmart has a paper jam.

Solution: Clear the paper jam.

For more information, see:

“Clear paper jams” on page 71

Cause: The print carriage is blocked.

Solution: Turn the HP Photosmart off and open the print cartridge door to access
the print carriage area. Remove any objects that are blocking the print carriage
(including any packing materials), and then turn the HP Photosmart on again.
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Follow the prompts on the display to continue.

CD/DVD tray open
Cause: The CD/DVD tray is open and a print job is started from the computer.

Solution: Close the CD/DVD tray.

CD/DVD tray misaligned
Cause: The CD/DVD holder is loaded incorrectly in the CD/DVD tray.

Solution: Remove the CD/DVD holder from the CD/DVD tray and then reinsert the
holder. Make sure you push the CD/DVD holder into the tray evenly. Push the holder
forward until the lines on the CD/DVD holder line up to the white lines on the CD/DVD
tray.

Insert CD/DVD holder
Cause: The HP Photosmart prompts you to insert the CD/DVD holder for a single
CD/DVD print job.

Solution: Load the printable disc onto the CD/DVD holder with the printable side
up. Lower the CD/DVD tray. Push the holder forward until the lines on the CD/DVD
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holder line up to the white lines on the CD/DVD tray. The end marked with arrows
goes into the CD/DVD tray first.

For more information, see:
“Load a CD/DVD” on page 23

Cause: The HP Photosmart prompts you to insert the next disc when printing
multiple CD/DVDs in a print job.
Solution: Remove the CD/DVD holder from the CD/DVD tray. Remove the printed
CD/DVD from the holder. Load the next disc onto the CD/DVD holder with the
printable side up and push the CD/DVD holder back into the CD/DVD tray until the
lines on the holder line up to the white lines on the CD/DVD tray.

Open CD/DVD tray
Cause: The CD/DVD tray is closed and a CD/DVD print job is started from the
computer.

Solution: Lower the CD/DVD tray. To continue, press OK.

CD/DVD holder not found
Cause: The CD/DVD holder is not inserted or it is not pushed in far enough.

Solution: Load a printable disc onto the CD/DVD holder with the printable side up.
Lower the CD/DVD tray. Push the holder forward until the lines on the CD/DVD holder
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line up to the white lines on the CD/DVD tray. The end marked with arrows goes into
the CD/DVD tray first. To continue, press OK.

CD/DVD not found
Cause: A printable CD/DVD is not found in the holder.

Solution: Remove the CD/DVD holder from the CD/DVD tray. Load a printable disc
onto the CD/DVD holder with the printable side up, and then push the CD/DVD holder
back into the CD/DVD tray until the lines on the holder line up to the white lines on
the CD/DVD tray. To continue, press OK.

Two-sided printing accessory is missing
Cause: The Two-sided printing accessory is not installed or it is installed incorrectly.

Solution: Firmly insert the Two-sided printing accessory into the back of the device
until both sides snap into place.

NOTE: Do not press the buttons on either side of the accessory when installing
it. Use the buttons only when removing the accessory from the device.

File messages
The following is a list of file-related error messages:

• Error reading or writing the file
• Unreadable files. NN files could not be read
• Photos not found
• File not found
• Invalid file name
• File corrupted
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Error reading or writing the file
Cause: The HP Photosmart software could not open or save the file.

Solution: Check to see if you typed the correct folder and file name.

Unreadable files. NN files could not be read
Cause: Some of the files on the inserted memory card are damaged.
Solution: Reinsert the memory card in the HP Photosmart or try transferring the
files to your computer using a memory card reader or a USB cable. If you already
transferred the files to your computer, try printing those files by using the
HP Photosmart Software. The copies might not be damaged. If these solutions do
not work, retake the photos with your digital camera as a last resort.

Photos not found
Cause: Some of the files on the inserted memory card are damaged.

Solution: Reinsert the memory card in the HP Photosmart or try transferring the
files to your computer using a memory card reader or a USB cable. If you already
transferred the files to your computer, try printing those files by using the
HP Photosmart Software. The copies might not be damaged. If these solutions do
not work, retake the photos with your digital camera as a last resort.

Cause: There are no photos found on the memory card.

Solution: Take some photos with your digital camera, or if you previously saved
photos on your computer, you can print them using the HP Photosmart Software.

File not found
Cause: There is not enough available memory on your computer to create a print
preview file.

Solution: Close some applications and try the task again.

Invalid file name
Cause: The file name you entered is invalid.

Solution: Make sure that you are not using any invalid symbols in the file name.

NOTE: Although the file name might look correct, it could still include invalid
characters. Overwrite the existing file name with a new name.

File corrupted
Cause: Some of the files on the inserted memory card are damaged.
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Solution: Reinsert the memory card in the HP Photosmart or try transferring the
files to your computer using a memory card reader or a USB cable. If you already
transferred the files to your computer, try printing those files by using the
HP Photosmart Software. The copies might not be damaged. If these solutions do
not work, retake the photos with your digital camera as a last resort.

Cause: The file system is corrupted.

Solution: Check the computer screen for an error message telling you that the
images on the memory card are corrupted.

If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

General user messages
The following is a list of messages related to common user errors:

• Memory card error
• Disconnected
• Out of disk space
• Card access error
• Use only one card at a time
• Card is inserted incorrectly
• Card is not fully inserted
• Card is damaged
• CD/DVD is upside down
• CD/DVD printing problem
• CD/DVD size mismatch

Memory card error
Cause: There are two or more memory cards inserted into the HP Photosmart at
the same time.

Solution: Remove all but one memory card. The HP Photosmart reads the
remaining memory card and displays the first photo stored on the memory card.

Cause: You have inserted a Compact Flash memory card backwards or upside
down.

Solution: Remove the memory card and reinsert it correctly. The label of the
Compact Flash card faces up and should be readable as you insert it into the slot.

Cause: You have not fully inserted the memory card.
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Solution: Remove the memory card and reinsert it in the memory card slot until it
stops.

Disconnected
Cause: Several situations can cause this error message to appear.
• Your computer is not turned on.
• Your computer is not connected to the HP Photosmart.
• The software that came with the HP Photosmart was not installed correctly.
• The software that came with the HP Photosmart is installed, but it is not running.

Solution: Make sure your computer is turned on and is connected to the
HP Photosmart. Also make sure you installed the software that came with the
HP Photosmart.

For more information, see:

“Communication problems over a USB connection” on page 69

Out of disk space
Cause: There is not enough available memory on your computer to perform the
task.

Solution: Close some applications and try the task again.

Card access error
Cause: There are two or more memory cards inserted into the HP Photosmart at
the same time.

Solution: Remove all but one memory card. The HP Photosmart reads the
remaining memory card and displays the first photo stored on the memory card.

Cause: You have inserted a Compact Flash memory card backwards or upside
down.

Solution: Remove the memory card and reinsert it correctly. The label of the
Compact Flash card faces up and should be readable as you insert it into the slot.

Cause: You have not fully inserted the memory card.

Solution: Remove the memory card and reinsert it in the memory card slot until it
stops.

Use only one card at a time
Cause: Multiple memory cards are inserted in the HP Photosmart.

Solution: You can insert only one memory card at a time.
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If more than one memory card is inserted, the Attention light will blink rapidly, and an
error message will appear on the computer screen. Remove the additional memory
card to resolve the problem.

Card is inserted incorrectly
Cause: The card is inserted backwards or upside down.

Solution: Turn the memory card so that the label side is up and the contacts are
facing the HP Photosmart, and then push the card forward into the appropriate slot
until the Photo light turns on.

If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Card is not fully inserted
Cause: The card is not fully inserted.

Solution: Make sure you fully insert the memory card into the appropriate slot on
the HP Photosmart.

If the memory card is not inserted properly, the HP Photosmart will not respond and
the Photo light (near the memory card slots) will not turn on.

After the memory card has been inserted properly, the Photo light will blink for a few
seconds, and then remain lit.

Card is damaged
Cause: You formatted the card on a Windows XP computer. By default, Windows
XP will format a memory card of 8 MB or less and 64 MB or more with the FAT32
format. Digital cameras and other devices use the FAT (FAT16 or FAT12) format and
cannot recognize a FAT32 formatted card.
Solution: Reformat your memory card in your camera or format your memory card
in a Windows XP computer by selecting the FAT format.

Cause: The file system is corrupted.

Solution: Check the computer screen for an error message telling you that the
images on the memory card are corrupted.
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If the file system on the card is corrupt, reformat the memory card in your digital
camera.

CAUTION: Reformatting the memory card will delete any photos stored on the
card. If you have previously transferred the photos from your memory card to a
computer, try printing the photos from the computer. Otherwise, you will need to
retake any photos you might have lost.

CD/DVD is upside down
Cause: The CD/DVD is loaded upside down on the CD/DVD holder.

Solution: Make sure the CD/DVD is snapped onto the CD/DVD holder with the
printable label side up.

CD/DVD printing problem
Cause: The HP Photosmart stalled while printing.

Solution: Make sure that there is sufficient space behind the HP Photosmart and
that the CD/DVD exit slot on the back of the HP Photosmart is not blocked. If the
HP Photosmart is placed close to a wall, move it at least 7.5 cm (3 inches) away from
the wall.

CD/DVD size mismatch
Cause: The size of the CD/DVD currently loaded on the CD/DVD holder does not
match the size you specified when you started the print job from the computer.

Solution: Replace the CD/DVD currently loaded on the CD/DVD holder with a CD/
DVD that is the same size as specified in the print job, or cancel the print job and start
again to specify the correct size in the software.

Paper messages
The following is a list of paper-related error messages:

• Cannot load paper from input tray
• Ink is drying
• Out of paper
• Paper jam, misfeed or blocked carriage
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• Paper mismatch
• Wrong paper width

Cannot load paper from input tray
Cause: There is not enough paper in the input tray.

Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:

“Load full-size paper” on page 18

Ink is drying
Cause: Transparencies and some other media require a drying time that is longer
than normal.
Solution: Leave the sheet in the output tray until the message disappears. If it is
necessary to remove the printed sheet before the message disappears, carefully hold
the printed sheet on the underside or the edges, and place it on a flat surface to dry.

Out of paper
Cause: There is not enough paper in the input tray.

Solution: If the HP Photosmart is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. Follow the prompts on the display or the computer screen to continue your
print job.

For more information, see:
“Load full-size paper” on page 18

Cause: The Two-sided printing accessory is off the HP Photosmart.

Solution: If you removed the Two-sided printing accessory to clear a paper jam,
replace it.

For more information, see:

“Clear paper jams” on page 71

Paper jam, misfeed or blocked carriage
Cause: Paper has jammed the HP Photosmart.
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Solution: Clear the jam.

For more information, see:

“Clear paper jams” on page 71

Cause: The print carriage is blocked.

Solution: Turn the HP Photosmart off and open the print cartridge door to access
the print carriage area. Remove any objects that are blocking the print carriage
(including any packing materials), and then turn the HP Photosmart on again.

Follow the prompts on the display to continue.

Paper mismatch
Cause: The print setting for the print job does not match the paper type or size
loaded in the HP Photosmart.

Solution: Change the print setting or load the appropriate paper in the input tray.
For more information, see:

“Change the print settings for the current job” on page 28
“Information on paper” on page 70

Wrong paper width
Cause: The print setting chosen for the print job does not match the paper loaded
in the HP Photosmart.

Solution: Change the print setting or load the appropriate paper in the input tray.

For more information, see:

“Information on paper” on page 70
“Change the print settings for the current job” on page 28
“Load paper” on page 17
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Power and connection messages
The following is a list of power- and connection-related error messages:

• Communication test failed
• HP Photosmart not found
• Improper shutdown
• Two-way communication lost

Communication test failed
Cause: The HP Photosmart is turned off.

Solution: Look at the display on the HP Photosmart. If the display is blank and the
On button is not lit, the HP Photosmart is turned off. Make sure the power cord is
firmly connected to the HP Photosmart and plugged into a power outlet. Press the
On button to turn on the HP Photosmart.

Cause: The HP Photosmart is not connected to the computer.

Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.

For more information, see:

“Communication problems over a USB connection” on page 69

HP Photosmart not found
Cause: The USB cable is not plugged in properly.

Chapter 11

122 Troubleshooting

Troubleshooting



Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.

For more information, see:

“Communication problems over a USB connection” on page 69

Improper shutdown
Cause: The last time the HP Photosmart was used, it was not turned off properly.
If the HP Photosmart is turned off by turning off the switch on a power strip or by using
a wall switch, the device can be damaged.

Solution: Press the On button located on the control panel of the HP Photosmart
to turn the device on and off.

Two-way communication lost
Cause: The HP Photosmart is turned off.
Solution: Look at the display on the HP Photosmart. If the display is blank and the
On button is not lit, the HP Photosmart is turned off. Make sure the power cord is
firmly connected to the HP Photosmart and plugged into a power outlet. Press the
On button to turn on the HP Photosmart.

Cause: The HP Photosmart is not connected to the computer.
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Solution: If the HP Photosmart is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP Photosmart and the computer, as shown below.

For more information, see:

“Communication problems over a USB connection” on page 69

Print cartridge messages
The following is a list of print cartridge error messages:

• Low on ink
• Need alignment or alignment failed
• Print cartridge damaged or missing
• Print cartridge is missing, incorrectly installed, or not intended for your device
• Print cartridge is not compatible
• Print cartridge is not intended for use in this device
• Wrong pen in slot

Low on ink
Cause: At least one of the print cartridges is estimated to be low on ink and might
need to be replaced soon.

Solution: Have a replacement cartridge on hand to avoid printing interruptions. You
do not have to replace the cartridge until print quality deteriorates. If you have installed
a refilled or remanufactured print cartridge, or a cartridge that has been used in
another printer, the ink level indicator will be inaccurate or unavailable.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.
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Need alignment or alignment failed
Cause: The incorrect type of paper is loaded in the input tray.

Solution: If you have colored paper loaded in the input tray when you align the print
cartridges, the alignment fails. Load unused plain white letter or A4 paper into the
input tray, and then try the alignment again. If the alignment fails again, you might
have a defective sensor or print cartridge.
To find support and warranty information, go to the HP Web site at www.hp.com/
support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.

Cause: Protective tape is covering the print cartridges.

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Reinsert the print cartridges and verify that they are fully inserted and locked in place.

Cause: The contacts on the print cartridge are not touching the contacts in the print
carriage.

Solution: Remove and then reinsert the print cartridges. Verify that they are fully
inserted and locked in place.

Cause: The print cartridge or sensor is defective.
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Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Cause: You installed new print cartridges which might need alignment.

Solution: You must align the print cartridges to ensure excellent print quality.
If the alignment error persists and you cannot clear it, your print cartridge might be
defective. Check to see if your print cartridge is still under warranty and end of
warranty date has not been reached.

• If the end of warranty date has been reached, purchase a new print cartridge.
• If the end of warranty date has not been reached, contact HP support. Go to

www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

For more information, see:

• “Align the print cartridges” on page 61
• “Print cartridge warranty information” on page 131
• “Shop for ink supplies” on page 67

Print cartridge damaged or missing
Cause: The print cartridge is missing.

Solution: One or both of the print cartridges is missing. Remove and reinsert the
print cartridges and verify that they are fully inserted and locked in place. If the
problem persists, clean the contacts of the print cartridges.
For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: Protective tape is covering the print cartridges.

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
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covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Cause: One or both of the print cartridges are not installed or are installed
incorrectly.

Solution: One or both of the print cartridges are not installed or are installed
incorrectly. Remove and reinsert the print cartridges and verify that they are fully
inserted and locked in place. If the problem persists, clean the copper-colored
contacts of the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: The print cartridge might be damaged.

Solution: Check to see if your print cartridge is still under warranty and end of
warranty date has not been reached.
• If the end of warranty date has been reached, purchase a new print cartridge.
• If the end of warranty date has not been reached, contact HP support. Go to

www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Print cartridge is missing, incorrectly installed, or not intended for your device
Cause: The print cartridge is missing.
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Solution: One or both of the print cartridges is missing. Remove and reinsert the
print cartridges and verify that they are fully inserted and locked in place. If the
problem persists, clean the contacts of the print cartridges.

For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: Protective tape is covering the print cartridges.

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Cause: One or both of the print cartridges are not installed or are installed
incorrectly.

Solution: One or both of the print cartridges are not installed or are installed
incorrectly. Remove and reinsert the print cartridges and verify that they are fully
inserted and locked in place. If the problem persists, clean the copper-colored
contacts of the print cartridges.
For more information on print cartridges, see “Troubleshoot print cartridges”
on page 74.

Cause: The print cartridge is defective or not intended for use in this device.
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Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Print cartridge is not compatible
Cause: The indicated print cartridge(s) are not compatible with the HP Photosmart.

Solution: Replace the indicated print cartridge(s) with print cartridges that are
compatible with the HP Photosmart.
For a list of compatible print cartridges, see the printed documentation that came with
the HP Photosmart.

For more information, see:

• “Shop for ink supplies” on page 67
• “Replace the print cartridges” on page 54

Print cartridge is not intended for use in this device
Cause: The print cartridge is not intended for use in this device.

Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Wrong pen in slot
Cause: The print cartridge is inserted into the wrong slot.

Solution: Remove the print cartridge and insert it into the correct slot.

The tri-color print cartridge goes into the slot on the left.

The black or photo print cartridge goes into the slot on the right.

1 Print cartridge slot for the tri-color print cartridge

2 Print cartridge slot for the black and photo print cartridges
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For more information, see:

• “Replace the print cartridges” on page 54
• “Troubleshoot print cartridges” on page 74
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12 HP warranty and support
Hewlett-Packard provides Internet and phone support for the HP Photosmart.
This section contains the following topics:
• Warranty
• Print cartridge warranty information
• Support process
• Before you call HP support
• HP support by phone
• Additional warranty options
• HP Quick Exchange Service (Japan)
• HP Korea customer support
• Prepare the HP Photosmart for shipment
• Pack the HP Photosmart

Warranty
For more information about the warranty, see the printed documentation that came with the
HP Photosmart.

Print cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device.
This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished,
misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the end
of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be
found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the
HP Photosmart.

Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the HP Photosmart.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to

all HP customers. It is the fastest source for up-to-date device information and expert assistance
and includes the following features:
• Fast access to qualified online support specialists
• Software and driver updates for the HP Photosmart
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• Valuable HP Photosmart and troubleshooting information for common problems
• Proactive device updates, support alerts, and HP newsgrams that are available when you

register the HP Photosmart
3. Call HP support. Support options and availability vary by device, country/region, and language.

Before you call HP support
Software programs from other companies might be included with the HP Photosmart. If you
experience problems with any of those programs, you will receive the best technical assistance by
calling the experts at that company.

NOTE: This information does not apply to customers in Japan. For information on service
options in Japan, see “HP Quick Exchange Service (Japan)” on page 134.

If you need to contact HP support, do the following before you call:
1. Make sure that:

a. The HP Photosmart is plugged in and turned on.
b. The specified print cartridges are installed correctly.
c. The recommended paper is properly loaded in the input tray.

2. Reset the HP Photosmart:
a. Turn off the HP Photosmart by pressing the On button.
b. Unplug the power cord from the back of the HP Photosmart.
c. Plug the power cord back into the HP Photosmart.
d. Turn on the HP Photosmart by pressing the On button.

3. To find support and warranty information, go to the HP Web site at www.hp.com/support. If
prompted, choose your country/region, and then click Contact HP for information on calling for
technical support.
Check the HP Web site for updated information or troubleshooting tips for the HP Photosmart.

4. If you are still experiencing problems and need to speak with an HP support representative, do
the following:
a. Have the specific name of the HP Photosmart, as it appears on the control panel, available.
b. Print a self-test report.
c. Be prepared to describe your problem in detail.
d. Have your serial number ready.

You can view the serial number by looking at the sticker on the rear side of the
HP Photosmart. The serial number is the 10-character code in the upper left corner of the
sticker.

5. Call HP support. Be near the HP Photosmart when you call.

Related topics
“Print a self-test report” on page 58

HP support by phone
For a list of support phone numbers, see the printed documentation that came with the device.
This section contains the following topics:
• Phone support period
• Placing a call
• After the phone support period
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Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP Photosmart. Be prepared to provide
the following information:
• Model number (located on the label on the front of the HP Photosmart)
• Serial number (located on the back or bottom of the HP Photosmart)
• Messages that appear when the situation occurs
• Answers to these questions:

• Has this situation happened before?
• Can you re-create it?
• Did you add any new hardware or software to your computer at about the time that this

situation began?
• Did anything else occur prior to this situation (such as a thunderstorm, HP Photosmart was

moved, etc.)?

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call
the support phone number for your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP Photosmart at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the services and warranty area for
information about the extended service plans.
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HP Quick Exchange Service (Japan)

For instructions on how to pack your device for exchange, see “Pack the HP Photosmart”
on page 135.

HP Korea customer support
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Prepare the HP Photosmart for shipment
If, after contacting HP support or returning to the point of purchase, you are requested to send the
HP Photosmart in for service, make sure you remove and keep the following items before returning
your device:
• The print cartridges
• The control panel faceplate
• The power cord, USB cable, and any other cable connected to the HP Photosmart

CAUTION: The replacement HP Photosmart will not be shipped with a power cord. Store
the power cord in a safe place until the replacement HP Photosmart arrives.

• Any paper loaded in the input tray
• Remove any originals you might have loaded in the HP Photosmart
This section contains the following topics:

To remove print cartridges before shipment
1. Turn on the HP Photosmart and wait until the print carriage is idle and silent. If the HP Photosmart

will not turn on, skip this step and go to step 2.
2. Open the print cartridge door.
3. Remove the print cartridges from their slots.

NOTE: If the HP Photosmart does not turn on, you can unplug the power cord and then
manually slide the print carriage to the far right side to remove the print cartridges.

4. Place the print cartridges in an airtight plastic container so they will not dry out, and put them
aside. Do not send them with the HP Photosmart unless the HP customer support call agent
instructs you to.

5. Close the print cartridge door and wait a few minutes for the print carriage to move back to its
home position (on the left side).

NOTE: Make sure the scanner is idle and has returned to its parked position before turning
off the HP Photosmart.

6. Press the On button to turn off the HP Photosmart.

Pack the HP Photosmart
Complete the following steps after you have prepared the HP Photosmart for shipment.

To pack the HP Photosmart
1. If available, pack the HP Photosmart for shipment by using the original packing materials or the

packaging materials that came with your exchange device.

Prepare the HP Photosmart for shipment 135

H
P 

w
ar

ra
nt

y 
an

d 
su

pp
or

t



If you do not have the original packaging materials, please use other adequate packaging
materials. Shipping damage caused by improper packaging and/or improper transportation is
not covered under the warranty.

2. Place the return shipping label on the outside of the box.
3. Include the following items in the box:

• A complete description of symptoms for service personnel (samples of print quality problems
are helpful).

• A copy of the sales slip or other proof of purchase to establish the warranty coverage period.
• Your name, address, and a phone number where you can be reached during the day.
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13 Technical information
The technical specifications and international regulatory information for the HP Photosmart are
provided in this section.
For additional specifications, see the printed documentation that came with the HP Photosmart.
This section contains the following topics:
• Specifications
• Environmental product stewardship program
• Regulatory notices

Specifications
Technical specifications for the HP Photosmart are provided in this section. For additional
specifications, see the printed documentation that came with the HP Photosmart.

System requirements
Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web
site at www.hp.com/support.

Paper specifications

Type Paper weight Input tray* Output tray† Photo tray*

Plain paper 16 to 24 lb. (60 to
90 gsm)

Up to 125 (20 lb.
paper)

50 (20 lb. paper) n/a

Legal paper 20 to 24 lb. (75 to
90 gsm)

Up to 125 (20 lb.
paper)

50 (20 lb. paper) n/a

Cards 110 lb. index max
(200 gsm)

Up to 40 25 Up to 20

Envelopes 20 to 24 lb. (75 to
90 gsm)

Up to 15 15 n/a

Transparency film N/A Up to 40 25 n/a

Labels N/A Up to 40 25 n/a

5 x 7 inch (13 x 18 cm)
Photo paper

67 lb. Bond
(252 gsm)

Up to 40 25 20

4 x 6 inch (10 x 15 cm)
Photo paper

67 lb. Bond
(252 gsm)

Up to 40 25 20

L 3.5 x 5 inch (8.9 x 12.7
cm) Photo paper

67 lb. Bond
(252 gsm)

Up to 40 25 20

Letter (8.5 x 11 inch) /
A4 (210mmx297mm)
Photo paper

67 lb. Bond Up to 40 25 n/a
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Type Paper weight Input tray* Output tray† Photo tray*

(252 gsm)

* Maximum capacity.
† Output tray capacity is affected by the type of paper and the amount of ink you are using.

HP recommends emptying the output tray frequently.
* Maximum capacity.

NOTE: For a complete list of supported media sizes, see the printer driver.

Print specifications
• Up to 1200 x 1200 rendered dpi black when printing from a computer
• Up to 4800 x 1200 optimized dpi color when printing from a computer and 1200-input dpi
• Print speeds vary according to the complexity of the document
• Panorama-size printing
• Method: drop-on-demand thermal inkjet
• Language: PCL3 GUI
• Duty cycle: Up to 3000 printed pages per month

Print resolution
To find out about the printer resolution, see the printer software. For more information, see “View
the print resolution” on page 30.

Print cartridge yield
Visit www.hp.com/pageyield for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to:
www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been kept
to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been
designed to separate easily. Fasteners and other connections are easy to locate, access, and
remove using common tools. High priority parts have been designed to access quickly for efficient
disassembly and repair.
For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Energy Star® notice
• Disposal of waste equipment by users in private households in the European Union

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Chapter 13
(continued)

138 Technical information

Technical inform
ation

http://www.hp.com/pageyield
http://www.hp.com/support
http://www.hp.com/hpinfo/globalcitizenship/environment/index.html


Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP
conserves resources by reselling some of its most popular products. For more information regarding
recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Energy Star® notice
This product is designed to reduce power consumption and save natural resources without
compromising product performance. It has been designed to reduce total energy consumption both
during operation and when the device is not active. This product qualifies for ENERGY STAR® which
is a voluntary program established to encourage the development of energy-efficient office products.

ENERGY STAR is a U.S. registered service mark of the U.S. EPA. As an ENERGY STAR partner,
HP has determined that this product meets ENERGY STAR guidelines for energy efficiency.
For more information on ENERGY STAR guidelines, go to the following Web site:
www.energystar.gov
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Disposal of waste equipment by users in private households in the European Union

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.
Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants. 
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des 
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer 
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter 
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.
Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das 
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das 
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine 
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei 
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.
Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea 
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo 
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio 
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate 
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza, 
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.
Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es 
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos 
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los 
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la 
tienda donde adquirió el producto.
Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé 
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným 
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete 
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt 
zakoupili.
Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr 
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på 
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere 
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.
Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur 
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte 
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over 
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product 
hebt aangeschaft.
Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete 
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult. 
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme 
ostsite.
Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite 
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös, 
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen 
jälleenmyyjältä.
Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να 
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και 
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των 
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες 
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.
A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata, 
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik. 
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az 
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon 
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.
Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces, 
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde 
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var 
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.
Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją 
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga 
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio 
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za 
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów 
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można 
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.
Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos 
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do 
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais 
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que 
adquiriu o produto.
Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom 
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a 
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade, 
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem 
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili, 
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini, 
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation 
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både 
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar 
kasserade produkter för återvinning.
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Regulatory notices
The HP Photosmart meets product requirements from regulatory agencies in your country/region.
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This section contains the following topics:
• Regulatory model identification number
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• Noise emission statement for Germany
• Toxic and hazardous substance table
• Declaration of conformity (European Economic Area)
• HP Photosmart D5300 series declaration of conformity

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SDGOB-0732. This regulatory number should not be
confused with the marketing name (HP Photosmart D5300 series, etc.) or product numbers
(Q8360A, etc.).

FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified 
that the following notice be brought to the attention of users of this product. 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reason-
able protection against harmful interference in a residential installation.  This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by HP may void the user's authority to operate the 
equipment.
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions:  (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Noise emission statement for Germany

Geräuschemission

LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

Toxic and hazardous substance table
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Declaration of conformity (European Economic Area)
The Declaration of Conformity in this document complies with ISO/IEC 17050-1 and EN 17050-1. It
identifies the product, manufacturer’s name and address, and applicable specifications recognized
in the European community.

HP Photosmart D5300 series declaration of conformity

DECLARATION OF CONFORMITY 
according to ISO/IEC 17050-1 and EN 17050-1 

 

Manufacturer's Name: Hewlett-Packard Company DoC#: SDGOB-0732-rel.1.0 

Manufacturer's Address: 16399 West Bernardo Drive 
San Diego, CA 92127, USA 

 

declares, that the product 
 

Product Name: HP Photosmart D5300 Series (Q8360A) 

Regulatory Model:4) SDGOB-0732 

Product Options: ALL 

Power Adapter: 0957-2177, 0957-2178 
 

conforms to the following Product Specifications: 
 

SAFETY: IEC 60950-1:2001 / EN60950-1:2001  
IEC 60825-1 Ed. 1.2: 2001 / EN 60825-1 + A2 + A1: 2002 (LED)  
GB4943: 2001 

EMC: CISPR 22:1997 +A1:2000 +A2:2002 / EN55022:1998 +A1:2000 +A2:2003 Class B 3) 

CISPR 24:1997 +A1:2001 +A2:2002 / EN 55024:1998 +A1:2001 + A2:2003 Class B3)  

IEC 61000-3-2: 2000 + A1:2000 + A2:2005 / EN 61000-3-2: 2000 +A2:2005 
IEC 61000-3-3:1994 +A1: 2001 / EN 61000-3-3:1995 +A1: 2001 
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4  
GB9254-1998, GB17625.1-2003 

 

Supplementary Information: 

1. The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low 
Voltage Directive 73/23/EEC and carries the CE-Marking accordingly. 

2. This Device complies with Part 15 of the FCC Rules.  Operation is subject to the following two Conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation. 

3. The product was tested in a typical configuration. 

4. For regulatory purposes, these products are assigned a Regulatory model number. This number should 
not be confused with the product name or the product number(s). 

 

San Diego, CA, USA 
18 December, 2006  

For Regulatory Topics only, contact: 
European Contact:   Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, 
  Department HQ-TRE / Standards Europe, Herrenberger Strasse 140, D-71034 Böblingen, Germany (FAX: +49-7031-14-3143) 
USA Contact:  Product Regulations Manager, Hewlett Packard Company, San Diego, CA (858) 655-4100 
 

Regulatory notices 143

Te
ch

ni
ca

l i
nf

or
m

at
io

n



Chapter 13

144 Technical information

Technical inform
ation



Index

Symbols/Numerics
10 x 15 cm photo paper

specifications 137
13 x 18 cm photo paper

load 19
2 pages on 1, print 39
4 pages on 1, print 39
4 x 6 inch (10 x 15 cm)

borderless photos
print 35

5 x 7 inch photo paper, load 19

A
A4 paper, load 18
addresses, print 42
after the support period 133
align print cartridges 61
alignment

failed 125
print cartridges 125

B
booklet printing 38
borderless photos

print 35
print from memory card 48

brightness, change in print 31
buttons, control panel 6

C
cancel

button 7
print job 44

carriage
jam 110
stalled 109, 110

cartridges. See print cartridges
choose paper 15
clean

print cartridge contacts 62
print cartridge ink nozzle

area 64
print cartridges 62

color
dull 92
smeared 90

color graphics display 6
color tone, change in print 31
communication problems

test failed 122
two-way communication

lost 123
connection problems

device not found 122
HP All-in-One does not turn

on 80
connection types supported

printer sharing 11
control panel

buttons 6
features 6

crop
photos 50

customer support
warranty 131, 133

D
declaration of conformity

European Economic
Area 143

United States 143
default printer, set as 28
device

no response 95
not found 122

disconnected error 117
Display

icons 7
double-sided prints 37, 38

E
edit

photos 50
edit photos 51
envelopes

load 21
specifications 137

environment
Environmental product

stewardship program 138
error messages

memory cards 116

out of paper 120
reading or writing file 115

F
fax

paper width incorrect 121
poor quality printouts 88, 89

fax problems
poor print quality 89
smeared ink 88

file
invalid name 115
unreadable 115

firmware revision mismatch 111

G
greeting cards, load 22

H
Hagaki, load 20
HP Photosmart

send images 51

I
improper shutdown 123
index cards, load 20
ink

drying time 120
low 101, 124
sprays inside

HP Photosmart 102
ink cartridges. See print

cartridges
ink levels

icons 7
ink levels, check 59
ink supplies

purchase 67
ink, removing ink from skin and

clothing 65
invalid file name 115
iron-on transfers 41

J
jams, paper 25
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L
labels

load 22
specifications 137

landscape orientation 31
left arrow 6
legal paper

load 18
specifications 137

letter paper
load 18
specifications 137

load
13 x 18 cm photo paper 19
5 x 7 inch photo paper 19
A4 paper 18
envelopes 21
full-size paper 18
greeting cards 22
Hagaki 20
index cards 20
iron-on transfers 22
labels 22
legal paper 18
letter paper 18
postcards 20
transparencies 22

M
maintenance

align print cartridges 61
check ink levels 59
clean print cartridges 62
print cartridges 53
replace print cartridges 54
self-test report 58
Standby/Off, set mode 66

margins
incorrect 99
text or graphic cut off 100

media. See paper
memory cards

digital camera cannot
read 102

e-mail photos 51
error message 116
file unreadable 115
HP Photosmartcannot

read 103
insert 50
photos missing 115
print photos 48
save files to computer 50

share photos 51
slots 47
troubleshoot 102

O
OK button 6
on button 7
order

ink supplies 67
print cartridges 67

out of paper 120
overheads, print 41

P
page order 40
paper

choose 15
feed fails 94
incompatible types 17
jam 111, 120
jams 25, 71
load 17
misfeed 120
out of 120
recommended sizes for

printing 28
recommended types 15
size incorrect 121
specifications 137
tips 70
type incorrect 121
width incorrect 121

paper type 29
phone numbers, support 132
phone support 132
phone support period

period for support 133
photo paper

load 19
specifications 137

photos
borderless 48
e-mail 51
edit 50, 51
ink sprays 102
missing 115
photo print cartridge 59
print borderless 35
print on photo paper 35
send using HP

Photosmart 51
share 51

poor fax printout quality 88, 89
portrait orientation 31
postcards

load 20
posters 43
preview print job 32
print

2 or 4 pages on 1 39
addresses 42
blank printout 101
booklet 38
borderless fails 95
borderless photos 35
both sides of page 37
cancel job 44
CD/DVD labels 36
correct order 40
distorted printout 90
envelopes 42
envelopes print

incorrectly 94
faded 92
from computer 27
from software application 27
iron-on transfers 41
labels 42
margins incorrect 99, 100
meaningless characters 97
multiple pages on one

sheet 39
nothing happens 97
on photo paper 35
photos from memory

card 48
posters 43
preview 32
print options 28, 32
quality, troubleshoot 88, 89,

91, 93
reverse images 41
reversed page order 99
self-test report 58
special print jobs 34
specifications 138
transparencies 41
troubleshooting 94
vertical streaks 93
Web pages 43

print cartridge protector 60
print cartridges

align 61, 125
check ink levels 59
clean 62
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clean contacts 62
clean ink nozzle area 64
damaged 126
error message 126, 127
handle 54
incorrect 127
low ink 101
low on ink 124
missing 126
order 67
part names 54
photo print cartridge 59
replace 54
store 60
tips 71
troubleshoot problems 74

print quality 30
print settings

brightness 31
color tone 31
layout 31
orientation 31
paper size 28
paper type 29
print quality 87
quality 30
reduce/enlarge 31
resizing options 31
resolution 30
saturation 31
speed 30

printer sharing
Mac 11
Windows 11

Printing Shortcuts tab 33
problems

error messages 109
print 94

Q
quality

print 30

R
recycle

ink cartridges 139
regulatory notices

declaration of conformity
(European Economic
Area) 143

declaration of conformity
(U.S.) 143

regulatory model
identification number 141

reinstall software 85
removing ink from skin and

clothing 65
replace print cartridges 54
reports

self-test 58
resolution

print 30
right arrow 6

S
saturation, change in print 31
save

photos to computer 50
self-test report 58
set

print options 28, 32
ship your device 135
smeared ink, fax 88
software application, print

from 27
software installation

reinstall 85
troubleshoot 83
uninstall 85

speed
print 30

stop
print job 44

support
contact 132

support process 131
system requirements 137

T
T-shirt transfers. See iron-on

transfers
technical information

paper specifications 137
print specifications 138
system requirements 137

telephone numbers,
support 132

text
cut off 100
jagged 89
meaningless characters 97

not filled in 89
smooth fonts 89

transparencies
load 22
specifications 137

troubleshoot
cd/dvd print 105
fax problems 88, 89
hardware installation 80
jams, paper 25
software installation 83
USB cable 81

troubleshooting
communication problems 69
error messages 109
memory card 102
print 94

two-sided prints 37, 38

U
uninstall software 85
USB cable

communication lost 123
USB cable installation 81

W
warranty 131, 133
Web pages, print 43

Index
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